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This document contains confidential information that is subject to U.S. and international copyright laws
and treaties. No part of this document may be reproduced in any form without the written
authorization of TIBCO Software Inc.

TIBCO and Two-Second Advantage TIB, TIBCO Adapter, Predictive Business, Information Bus, TIBCO
BusinessConnect, TIBCO ActiveMatrix BusinessWorks, TIBCO Enterprise Message Service, TIBCO
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Edition (J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of
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All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT
ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED
AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE
VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
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THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
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TIBCO Documentation and Support Services

Documentation for this and other TIBCO products is available on the TIBCO Documentation site:
https://docs.tibco.com

Documentation on the TIBCO Documentation site is updated more frequently than any documentation
that might be included with the product. To ensure that you are accessing the latest available help
topics, please visit https://docs.tibco.com.

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site. To directly access documentation for this product, double-click the
following file:

TIBCO_HOME/release_notes/TIB_bstudio-mdm_5.0.0_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows,
the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documents for this product can be found on the TIBCO Documentation site:

e TIBCO MDM Studio Release Notes

e TIBCO MDM Studio Installation Guide

e TIBCO MDM Studio Process Designer Tutorial

e TIBCO MDM Studio Process Designer User’s Guide

e TIBCO MDM Studio Repository Designer Tutorial

e TIBCO MDM Studio Repository Designer User’s Guide
e TIBCO MDM Studio Rulebase Designer Tutorial

e TIBCO MDM Studio Rulebase Designer User’s Guide

e TIBCO MDM Studio Ul Builder Tutorial

» TIBCO MDM Studio UI Builder User’s Guide

How to Contact TIBCO Support
For comments or problems with this manual or the software it addresses, contact TIBCO Support:

e For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

* If you already have a valid maintenance or support contract, visit this site:
https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCOmmunity

TIBCOmmunity is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCOmmunity offers
forums, blogs, and access to a variety of resources. To register, go to the following web address:

https://www.tibcommunity.com

TIBCO® MDM Studio Rulebase Designer User's Guide
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Overview

A repository consists of a list of records, each with its own set of attributes. Each attribute is defined as
being of a particular type and having a certain length.

A repository rule allows you to specify more complex constraints on attributes. For example, a
repository defines Price as a Number. Using a repository rule, you can specify that this number must be
between 0 and 100. You can also specify that, if Price is not zero, another attribute (Currency) must
have a specified value.

A repository rule is an encapsulated piece of business logic that specifies validations, transformations,
and access controls for a record. Some examples are:

¢ The storage temperature must be between —20F and 80F.

¢ The product effective date must be before the product first ship date.

¢ The subclass code must be Chicken, Beef, or Vegetable when the product class code is Soup.

* Volume is calculated by multiplying height x depth x length.

¢ Only Supervisors can access records with Product Code equal to ‘HS'.

Repository rules are specified in Rulebase files. Two files can be defined for a repository:

e New record file — called to initialize a new record

¢ Validation file — called for existing records

e Search control rules file — called from record search.

For detailed information on the Rulebase files, refer to the section Establish a Rulebase File.

The Rulebase file of a repository rule consists of a header, variable declarations, and a constraint. The
header gives the name and description of the rule. The constraint contains a condition and an action. The
condition describes when the rule needs to be applied. The action describes what the rule actually does
and controls which attributes the rule is applicable to. For detailed information, refer to the
sectionGlobal Property Settings for Rules.

Rulebase Designer Overview

The TIBCO MDM Rulebase Designer provides an intuitive graphical user interface to help business
users understand and design rule and rule flows for MDM.

The Rulebase Designer adds a visual element to designing rulebases and makes the process quicker and
more intuitive.

The Rulebase Designer is based on TIBCO Business Studio and acts as an 'add on' component to
Business Studio. Rulebase models are stored in a .rul format, contained in a special folder called
Rulebase Models.

What you can do with the Rulebase Designer
The Rulebase Designer provides an interface to:

* Graphically declare Variables and Constraints.
e Graphically define If-Then-Else conditions (flowchart representation).
e Graphically define Actions corresponding to Then or Else conditions.

e Define Expressions through an expression editor (for Conditions/Actions described by expressions
and where clauses).

e Define Expressions with ease using the context sensitive help in the expression editor.
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e Drag and drop semantics in the expression editor.
e Check syntax of rules at development time.
¢ Import existing rulebases.

e Direct deployment to MDM using network deployment on the MDM Server.

Establish a Rulebase File

&

Following rulebase files can be defined for a repository:

¢ New record file — called to initialize a new record
e Validation file — called for existing records

e Search control rules file — called from record search.

The new record file is called when adding a new record. Subsequently, the validation file is called when
modifying the record. The names of these files are defined using the Configurator. The default names
are as follows:

e InitialConfig > Rule Base > New Record Data Population Rulebase File Name = newrecord.xml

¢ InitialConfig > Rule Base > Record Save Validation File Name = catalogvalidation.xml

e InitialConfig > Rule Base > Record Search Rules File Name = searchcontrolrules.xml

% Do not rename the default rulebase file, catalogvalidation.xml, generated by the
system.

When a repository is created, these files are created in folder $MQ_COMMON_DIR/<enterprise-

internal-name>/catalog/master/<repository id>.
The <repository id> can be obtained from the Repository List page.

These validation files are also supported for a relationship catalog. This catalog is created when any
relationship attribute is defined for the relationship. The initialization or validation for relationship
attributes can be defined in these files. The ID of relationship catalog can be obtained from the database
by executing the following SQL:

select relationshipcatalogid from relationshipdefinition where ownerid=<repository
id> and name=<relationship name> and active='Y

For a list of supported actions for a relationship catalog, refer to the Relationship and Multi-value
Attributes Vs Regular Attributes section of the TIBCO MDM User’s Guide.

The system looks for these files in the following order:
$MQ_COMMON_DIR/<enterprise-internal-name>/catalog/master/<repository id>

$MQ_COMMON_DIR/standard/rulebase

‘ The second location is checked only when no file is specified in the first location.

Refer to Chapter 1 of the TIBCO Installation and Configuration Guide for details on MQ_HOME and
MQ_COMMON_DIR, under the environment variables section.

New Record File

&

A new record file is used to assign default values to the attributes of a new record. Assigned values
must come from constants or function calls.

This file is also used for propagation of attribute values to child records.

Some rules from the Validation File also come into play for new records.

‘ Drop downs can be filled up only through a constraint in the catalogvalidation.xml file.
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Validation File
The validation file usually contains the bulk of the rules. All kinds of rules are applicable:
* assignments
e validations
e propagations

e access controls

Search Control Rules File

The search control rules file is used to configure drop-down for attributes on the Record Search screen.

Global Property Settings for Rules

The TIBCO MDM stores some system wide configuration parameters for rules in the
ConfigValues.xml file.

These properties are set using the Configurator.

LogFlag
This parameter produces rulebase execution logs in the $MQ_COMMON_DIR/Temp directory. It should be
used for development or debugging only and should not be enabled in a production environment.

This parameter can be specified in System Debugging > RuleBase Debug Mode of the Configurator.
The Rulebase debugging requires large amount of disk space. Below is an example of how to set it to
true so a detailed stack trace can be obtained for rule base execution.

Log files start with "rb" and end with ".xm1". Several files can be produced in one go; browse to locate

the right file.
Log Files
rbbl*.xml First pass of rulebase. Computes propagations.
rbb2* . xml Propagations.
Tbb3*.xml Second pass of rulebase. This is the file you need for debugging validations and
assignments.

Attribute Names Checking

Setting the Configurator > Miscellaneous > Check Attribute Names parameter to true halts the
processing (throw an exception) if an attribute in the rulebase is not present in the repository.

If this parameter is set to false, an error is logged in error.log and a null value is returned for that
attribute and normal processing continues.

This parameter is provided mainly for backward compatibility with previous versions. In past versions,
attributes not found in the repository were ignored. Now, more stringent checking is present, which
can cut down on "typo" type errors, but it also means a rulebase that references a deleted attribute will
no longer work.

The recommended approach is to set this flag to true in the system where you need to use the rulebase
so that the system will alert you immediately if a rulebase contains an invalid attribute reference.
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Date Formats allowed in Rulebase

The following date formats are supported in rulebase:

e mm/dd/yyyy (default date format)
¢ dd-mon-yyyy

e mm/dd/yy

* ddmmyyyy

* yyyy-mm-dd

* yyyy/mm/dd

¢ dd-mm-yyyy

* dd/mm/yyyy

e dd-mm-yy
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Getting Started

This chapter explains how to start the Rulebase Designer, what you will see at startup, information on
accessing samples, tutorials, and help, and elements in the perspective.

Starting MDM Rulebase Designer

Procedure

1. After the installation completes, start the MDM Rulebase Designer by selecting Start > Program
Files > TIBCO > <environment name> > TIBCO Business Studio <ver> > TIBCO Business Studio.

2. Provide a workspace location (folder where projects will be saved).

Result

M workspace Launcher x|
Select a workspace

TIBCO Business Studio stores your projects in a folder called a workspace.
Choose a warkspace folder ko use For this session,

Workspace: IC:\DU:uments and Settingsiabciworkspace ﬂ Browse. .. |

™ Use this as the default and do not ask again

Cancel |
TIBCO Business Studio opens up and you are ready to start using it.

Welcome Screen
After you select the workspace for the first time, Eclipse opens up with the Welcome screen.

This contains icons to samples and tutorials among other things.

This Welcome screen shows up only the first time and will not be displayed for subsequent openings of
Eclipse. If you want to go to this screen again, you can access it from Help > Welcome.

&

File Edit Mavigate Search Project Run  Window Help

o)
Samples
Try out the samples

Accessing Samples

TIBCO MDM Studio Samples are a collection of the MDM standard processes, process modeling

tutorials, repository data models, rulebase model, custom import project, MDM Model templates, and
Process java transistions.

The sample models are provided to illustrate the modeling capabilities of MDM Studio. Each of these
models needs further elaborations for their intended purpose. Install the sample projects to view the

MDM processes, data models, and their associated rules. All the samples are available in the
TIBCOHome directory.

Follow these steps to install the Samples.
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Procedure

1. On the File menu, click Import.The import wizard is displayed.

2. From the General folder, select Existing Studio Projects into Workspace.

3. Click Next. The import wizard for selecting the directory path is displayed.

4. Click Select archive file option. Click Browse and select the sample project zip archives from

\<TIBCOHome>\ studio-mdm\ 5.0\ samples folder.
5. Click Finish. The select project opens in the workspace.

Accessing TIBCO MDM Studio Help
Help can be accessed by

Click Help > Help Contents.
Expand the TIBCO MDM Studio in the Help window.

r B

Search: Scope: All topics
Contents =1~ | =0~ E| g P o= ¥l @ A8
L 3

TIBCO MDM Studio

Contents

* Process Designer User’s Guide

» Repository Designer User's Guide
» Rulebase Designer User’s Guide

+ Ul Builder User’s Guide

* Process Designer Tutorial

+ Rulebase Designer Tutorial

» Repository Designer Tutorial

+ Ul Builder Tutorial

] = 4 Bl I

Modeling Perspective

The Modeling Perspective consists of the following views:

* Project Explorer

e Diagram Editor

e Properties Tab

e Rulebase Data View

e Problems Tab
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Palette

Project Explorer
A hierarchical view of resources that lists all existing projects and files under projects.

E A

ulebase Model Samples
+1-{E| Repository Models
EHE, Rulebase Models

E‘ita demoallactions.rb

E@ RulebaseDema

E||E| Constraint Container
[]--*ﬁ@ CnkAccChkPrp
[]--*ﬁ@ CnkAddressConnect
[]--*ﬁ@ CntAsgarray
[]--*ﬁ@ CnkAsgCrIneCnn
- E-AlR CrkCnnwithsaF
- E-Afp Crtselsisof
EE Declare
i
& warADDRESSRECORDS
E} warfrray
e ywarDs
2N yarlinkCatalogCustomer
-2 varlinkRecord
- yarlinkRelCustToddd
-2 varlinkRelRecordCust Tosdd

Diagram Editor
Enables graphical creation of rulebases. Consists of two sections:

The diagram editing canvas (to design and edit a rulebase diagram).

The Palette (for selection of artifacts such as variables and constraints).

Properties Tab
This view allows for editing of properties of rulebase components in the diagram.

Editable and non-editable fields for the selected component in the canvas is displayed in the Properties
Tab.

<NO TYPE>
(S Declare Variables [E] Declare Canstraints
= varlinkRelRecordCust Toadd E@& CntaccChkPo
e warlinkRecord r@l ChtasgCIneCnn
Y
1
= Properties 53 |_—E_-, Problems} @ Error Log}
=y varlinkRelRecordCustToAdd
S|
General * Mame: varlinkRelRecordCustToAdd
Advanced
Usage: ILocaI j
* Link bype: IRelationship Record j
* Literals: Type | Literal |
Reelationship CustomerToAddress
Record Attribute Mone
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Rulebase Data View
This view lists MDM artifacts imported through the Import Metadata artifacts.

[2, Rulebase Data % . [{ Deployment S =0
= = =
type filter text

4 |[= Rulebase Domain Objects -
4 [= Domain Objects
> B DataSources
. BB Repositories
> ",_’8 Roles
> B Users
4 [= Operators
> 3% Math
- #= Relational
4 = Functions
> 2¢ Comparison
» X Math
- BBf String
> ¥F Other
» ¥F Classification
4 = Variables
> JC SESSION
» (] WORKITEM
> &Y SYNCH_HISTORY
- |8 SYSTEM
s = Other
> L WORKFLOW
> JC ATTRIBUTEHISTORY
> JC ATTRIBUTEQUALITY
> JC PRECEDENCERESULT
> Wy User Defined
4 [= Templates
|= countFunction

m

= lockupFuncUsingEnum

Problems Tab
Displays errors (encountered in the current instance) to help diagnose problems with the Rulebase
plug-in.

Palette
The Palette (to the right of the screen) contains different artifacts to help build a rulebase.

Select and drop into the main drawing pane to define or modify a rulebase model.

Main Palette
This is the main palette; it enables you to declare variables and constraints for your basic rulebase.

Declare Variables

Create a new data type variable.
— Relationship B, Data-type

Create a new link type variable.
e Link-type

Declare Constraint

Create a new constraint.
E@p Conskraink

Declare Decision Table
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Create a new Decision Table.

Expression Editor Palette

This palette corresponds to constraints and provides icons to define conditions and actions .

Actions

@ Access

Create a new Access action.

<= ApplyPrecedence

Create a new ApplyPrecedence action.

<= Assign

Create a new Assign action.

4 Assign Identity

Create a new Assignldentity action.

Create a new Categorize action.

852 Categorize
) Create a new Check action.
& Check
Create a new Clear action.
(&) Jear
Create a new Connect action.
=0 Zonnectk
Create a new Disconnect action.
o2 Disconneck

:‘E Include

Create a new Include action.

¢ Propagate-Inline

Create a new Propagate Inline action.

¢ Propagate-Rulebase

Create a new Propagate Rulebase action.

of Select

Create a new Select action.

EHf Slice

Create a new Slice action.

{7 Softlink

Create a new Softlink action.

EE@@ UnCategorize

Create a new UnCatgorize action.

Condition Expression

E3 Expression

Create new Expression.
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Create new Group Expression.
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@ AND

Create new AND Operator.

o OR,

Create new OR Operator.

Wv MokExpression

Create new Not Expression.

The Not Expression returns negation of an expression. If an
expression value returns "true" then that expression written
inside the "NotExpression" returns "false" as a result value. These
kind of expressions are used when you need negation of
computational expressions.

E’: MotGroupExpre. ..

Create new Not Group Expression.

The Not Group Expression returns negation of an expression. If
an expression value returns "true" then that expression written

inside the "NotGroupExpression" returns "false" as a result value.

These kind of expressions are used when you need negation of
computational expressions.

HTML Tooltips

For ease of use, help is displayed when hovering over elements in the Ul

For example, in the Rulebase Data View, hover over functions to get a detailed description of that
function including syntax and an example.

Or hover over a variable to get the description for that variable.

5= outlin 59 Deplo E_ERuleb £3 =08
S EHESEE
Itype filter text
E:? Other ;I
;? checkdigit
~%F count
~%F distinct
~%F duplicate
% F enum
e
oo i filker —
=
wf ook - .
+{ Function ‘lookup
% max
. 1 J- =
:{ i | ookup value in datsbase,
-7 ml
:)7 2] Syntax:
:? skrip string lockup (string exprToleckup,object tableExpr)
37 synch exprioLookup:
. L expression to look up,
:{ e tableExpr: |
%7 tablel table expression.
4 | Returns: L
- A string value as a result of lockup operation.
] o Example: j
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Quick Search

Using the type ahead search dialog you can search for the variables declared in the Declare section and
the constraints declared in the Constraints section.

s 3

Repository : PERSON

[ peclare variahles [E] Declare Constraints

=iy COMTAINSLIMK f-'@& Cnt_Assignactionl

lp Cnit_sssignActiorz

lp Crit_Chieckaction

Bﬁ& Cnt_Prp rulebase and inling Action

Bﬁ& Cnt_Accessadion

Paol== = ch ariables or constraints|
@ Enter Search Pattern Above
28

Press Ctrl + F or click

&

in the toolbar the type ahead search dialog opens. Enter the search criteria in the Search Variable or
constraints field. The matching search result for the search criteria entered is shown.

s =

[ peclare variahles [E] Declare Constraints

S COMTATMSLINK R Crit_assignactiond
lp Cnit_sssignActiorz

Alp Crit_Chieckaction
A d RS I
BﬁQCnt_AccessAction Bﬁ& Cnt_Prp rulebase and inling Action
f-'ﬁNCnt_AssignActionl |
r-'@NCnt_.ﬂtssign.ﬂtctionZ |
AR cnt_cCheckaction Aln Crit_accessaction
r-'@NCnt_Prp rulebase and inline Action |

S COMTAIMSLIMNE
Constraink - -k

By default the search criteria shows both variables and constraints. You can restrict the search criteria to
show only variables or only constraint or both. Click Select Search Categories
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%
. It displays the Search Categories.
et 3
rrpreTrery————————r
(5] Dedlare Variatles [E] Dedare Canstraints
=y CONTATMSLINK U@N Cnt_Assignactionl

fp Cnit_sssignActiorz

<4 search Wariables or constraints |

(D Erter Search Pattern Above I‘Cnt_CheCkACti:n

SN Diagram Modes
Constraints
[] variables

\Ction

Select the Diagram Node checkbox if you want to include both Variables and Constraints in the search
result. select the Constraints checkbox if you want to include on constraints in search result. Similarly
select the Variables checkbox if you want to include only Variables in the search results.

Rulebase Navigation

The Rulebase model tree navigation is enhanced. It is categorized into the following five sections.

¢ Common

¢ Gdsn

e MassUpdate
¢ Other

e Search

The rulebases are grouped based on a specific category. For example, Rulebase of type Gdsn is grouped
into Gdsn folder, rulebase of type massupdate is grouped in MassUpdate folder. Similarly the Common
folder contains general type rulebases. The rulebase of type Other is grouped in Other folder and
rulebase of type search is grouped in Search folder.
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Create a New Rulebase

Before creating a rulebase you must create a project to hold the rulebase. The Create a New Rulebase
chapter explains in details how to create a new Rulebase.

Pre-Requisites for Creating a Rulebase

e Step 1 - Creating a new Project to hold your Rulebase Model

First create a project with containers (appropriate folders) for rulebase models and repository
models. Repository models are required because rules run on repositories.

e Step 2 - Defining or Importing Repository Data

Next, either create a repository model or import one (into the repository models folder) for
association with the rulebase.

& If you intend to create a Rulebase of type other than Initialization, Validation, or Search, you do not
need to associate a repository.

e Step 3 - Creating a Rulebase Model
Finally, create a rulebase model.
* Optional Steps - Importing Users and Roles

Optionally, import users and roles.

Creating a new Project to hold your Rulebase Model

To create a rulebase model, you first need to create a Project to hold your model.

Procedure

1. Go to File > New > Project . The Create New MDM Developer Project wizard is displayed.

P New Project |Z|@E|

Select a wizard

Create New MDM Developer Project

Wizards:

@ Analysis Project -~
@ BPM Developer Project
g Java Project
B Java Project from Existing Ant Buildfile
@ MDM Developer Project
@) opendrchitecturetiare Praject
L Plug-in Project
B Quality Process Project
@) Kbt Project
#(= General
#1-[= Business Inteligence and Reporting Toals
¥ = Business Modelling
#-(= Eclipse Modeling Framework
== EB g

2. Select MDM Developer Project and click Next.

3. Provide a name for the Project. Clear the Use default location checkbox if you want to provide a
different location for the project (by default, the current workspace). Select Destination
Environment as MDM. Click Next
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Project

Create a new project resource,

.

Project name: |

Use default location

Liocation: | Etlsudhirworkspace Erowse. ..
Id: |
Version: | 1.0.0.qualifier
[ mom
[] simulation
Destination
Environments:

26

4. The Asset Type Selection dialog is displayed - select the Repository Models and Rulebase Models

folders and click Next.

Asset Type Selection
Select the asset types to configure for the project.

Assets: Description:

4 @03 BPM
[T Business Assets
Business Processes

4 [H 3 Business Objects
[7] [ Business Object Model
[] [ CIM mIXML Model
DB Organization Model

a [J][3 Configurations

g} Configurations

a Datasources

[ Datasources

a [¥]C3 MDM UI Builder
@ U Builder

a [¥]3 Repository Models

[¥] (&) Repository Model

a Resource Bundle

© Resource Bundle

a Rulebase Models
[¥] [ Rulebase Model

a [¥) g Services

[ CIM Activity WSDL

% Service Descriptors

a Sync Formats

[#] 21 Synchrenization Format

@ [ <Back [{ Heds || Emsh ||

Cancel

)

5. The folder for the Repository Models and Rulebase Models is displayed. Click Finish. See

Rulebase Properties for more details.
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Set Special Folders

Set the following special Folders

Repositary Madel

&) Folder: | Repository Models

Rulehase Model

(2, Falder: | Rulebase Models

Defining or Importing Repository Data

&

27

Rules run on repository data. Before defining rules, the metadata you want the rules to run on must be

created, defined, or imported.

Procedure

1. Right click the Repository Models folder in the Project Explorer and select Import.

2. Select Import Repository Meta Data under MDM Repository Designer. Click Next.

-
gy Import

X

BT =S)

Select

Select an impert source:

type filter text

b

=

» [= MDM Process Designer
4 = MDM Repository Designer
Import Classification Code
HE Import Model From Database
£ Import Predefined QutputMap Meta Data
£, Impert Repository Meta Data
» [= MDM Rulebase Designer
» [= MDM Synchronization Format Designer
» [= Plug-in Development
» = Run/Debug
» = Service Registry
> (= SVN
» = Team
> (= XML
» (&= Other

m

| @ < Back

S

Enish

Cancel

4. Browse and select the repository meta data (.xml format). Click Finish.

TIBCO® MDM Studio Rulebase Designer User's Guide



Result
M MDM Repository Import Wizard |- |@‘E|
MDM Repository Import Wizard
Import Repository Meta Data
From Directory: | Et\Techpubsimetadata £
[E] (= metadata [ [%] reqsharedrymetabata. cml

Select all | | Unselect all

Into Folder: | ProjfRepository Models

Options
D Cwverwrite existing resources without warning

%] reqTest.xml

| Browse.. |

=

[ < Back. ” Mext = ” Finish ” Cancel ]

28

A repository (.rep) import file will be created under the target folder.

Creating a Rulebase Model

& Ensure that you have defined or imported repository metadata before attempting to create a rulebase

model.

Procedure

1. Right click the Rulebase Models folder in the Project Explorer and select New Rulebase Model.

L™ Project Explarer 53 =0
SR

@ Rulebase Model Samples
B @ RulebaseTest
{E] Repository Models

BS demoallactions.rb B2

[E peclare variables

- ot
= Copy Chrl+C “ File
Paste ErlY, [ Falder
3 Delete Delete [ 6L File
Special Folders
Move...
Rename... F2 ) Example. ..
S -
(23 Import... [ Other... Chri+h

2. Accept the default name for the rulebase model (default.rul) and location or enter a new location

and name. Click Next.
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Enter or select the parent falder:

Create Rulebase Diagram
Select file that will contain diagram model.

| ProjfRulebase Models

(=3
@ MDM Repository Model Sample
{39 MDM Rulebase Model Sample
{39 MDM Standard Processes
{39 New Project
1= product_webservice
= Proj
(= Repository Models
=z Rulebase Models
(= Comman
(= Gdsn
(= Masslpdate
(= Other
(= Search

>

4]

File name: | default.rul

3. Select the type of Rulebase: Initialization, Validation, Search, Other, Gdsn, MassUpdate.

% New Rulebase Diagram

Rulebase Type
Select Rulebase Type

Rulebase Type* | Validation

4. Click Next.

5. Associate repository data with your rulebase.

e Select the Repository Model .rep file. This is mandatory field.

e Select the Repository to associate. This is mandatory field.

»  Select the Relationship to associate.
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To associate a relationship, select the relationship’s source (and not target) repository
& from the Repository drop-down; the Relationship drop-down will then get
populated with available relationships that you can select to associate.

6. Click Finish.

Result
M New Rulebase Diagram (| (= ”5_(‘
Repository Model Information
Associate a repository model and repository with this rulebase.
Providing relationship is optional,
Repository Model* |Pruduct.rep v|
Repository™®
Relationship |Nnne v |

The rulebase diagram is then displayed in the Editor. Use the palette to start building your rulebase by
declaring variables and adding constraints. For more details, see Types of Variables.

ik x| =g
B Al
Repository : PRODUCTS R b
h®RD-
" (= Declare Yariables el
E Declare Vatiables [E beclare Constraints
[ Data-type
fn con 53 Link-type
(== Declare Constraint €@
&flp Constraint
[= Declare Decision Table <0
R, DecisionTable

Rulebase Properties

Double click the rulebase (.rul) file under the Rulebase Models folder in the Project Explorer to view or
change the properties.

General Properties

This displays the Rulebase Name, Description, and Type.
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E Properties &2 Ef._ Problems Q_-|Err0r Log %Data Source Explorer =t | =

= New Record Validations

General * MName: New Record Validations
Advanced
Description: MNew Record Validations pour grille =
Rulebase Type | Initialization -

Initialization

Advanced Properties
The following properties are displayed here:

e Error Severity: Defines the default severity for the rulebase and is set to 9 by default. All validations
with severity less than the set value are considered errors. All validations with severity greater than
the set value are considered warnings. You can override this rulebase level setting by going to an
individual constraint and changing its Severity.

¢ Information Threshold: Information threshold, set to 1 by default.
¢ Warning Threshold: Warning threshold, set to 99 by default.

¢ Parallelize: Indicates that this rulebase does not depend on order of execution of other rulebase
within record hierarchy and can be executed in parallel.

 TFirst Pass: When saving records, a rulebase is executed twice. The first time the rulebase handles
propagations and the second time, assignments or validations are done. Set this value to Required if
the parent record needs to propagate values to a child. Skip is the default option ( no propagations
defined in the rulebase).

e Metaversion: The version of the file.

» DParent First: If there are one or more parents in the hierarchy, evaluate the parent rulebase first. This
is usually used to indicate, the child record has a dependency on the parent or higher level parent
and parent record rulebase has to be processed prior to child.

e Skip If No Change: Indicates that for a record in the hierarchy, if records are not modified, no

validation be done. This directives applies only for operations which modify record (merge, modify,
delete).

| Properties &2 Ef._\ Problems @Error Log %Data Source Explorer =t | =

= New Record Validations

General Error severity: P First pass: Required -
Advanced
Information 1 Metaversion: 1.0 -
threshold:
Warning 99 Parent First: B
threshold:
Parallelize: Skip If No ]

Change:
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Actions Allowed for Different Types of Rulebases

The following actions are supported for different types of rulebases.

Rulebase Type Action Usage Filename
Initialization Assign Add newrecord.xml
Propagate
Relationship Assign While creating, need  newrecord.xml
Check to selgct parent searchcontrolrules.xml
repository and
Softlink relationship. catalogvalidation.xml
Select
Access
Search Select Browse and Search searchcontrolrules.xml
Validation All actions Add/Modify/View catalogvalidation.xml
Other Assign In other rulebase or  <filename>.xml
in workflow
Access -
activities.
Select
Include
Clear
GDSN commonly used to support gdsn <filenname_gdsn>.xml

actions like Assign,
Access, Select

MassUpdate Assign Advanced Mass <filename>.xml
Access Update
Select
Include
Clear

The Initialization, Validation, Search, and Other type Rulebases are saved in \ common_dir
\<Enterprise name>\ catalog\ master\<Catalog ID>\

The GDSN and Mass update type Rulebase are saved in \common_dir\<Enterprise name>

\rulebase\

The Relationship type Rulebase is saved in \common_dir\<Enterprise name>\ catalog\master

\<Relationship table ID>\
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Adding Rulebase To a Folder

To add a new rulebase to a particular folder.

Procedure

1. Select the folder in which you want to add the rulebase. Right-click on the folder (For example,
Common) and select New and click Rulebase Model.

r[\j Project Explorer 3 =0
=R A
{39 Dema
&9 Demal
59 Demo3
=] :H Demo4
= [ Rulebase Models

£ co IR [ 1.

£ tasg ¥ File
(= Oths =
5] Seart (% Folder
@ Business. [E] 561 File
U5 Datasour Import
Export
— [ Example. ..
\El| Reposital £ | Refresh F5
[ service [ [ Other... Chrl+h

21 Svnc For walidate
[ MDM Process  Run As 5
2 MOM Process  Debug As 4
2 Mo Repost| Profile fs v
58 Mo Rulebad Team v
{39 MDM Standal Compare With 4
{39 Mew Project Restore from Local History...

1= product_wet Saurce »
[§3 Deployment serv| £ Show Properties View erties £
Properties Alt+Enter

oo - Dolnhacn Madale

2. The Create Rulebase Diagram dialog is displayed.

M New Rulebase Diagram

Create Rulebase Diagram

Select File that will contain diagram model.

Enter or select the parent Folder:

| Demod/Rulebase Models/Common

(= Comman ~
= Gdsn
= MassUpdate
(= Other
= Search
(£ Service Descriptors
(= Sync Formats
bj‘J MDM Process Java Transitions
by MDM Process Model Tutorial
w MDM Repository Model Sample
ﬂ MDM Rulebase Model Sample
by MDM Standard Processes
b’_’-’ e Project

File: name:
Advanced »>

£

3. Enter appropriate rulebase base name in File name field.

4. Click Next. The Rulebase Type selection dialog is displayed.
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f B
w4y New Rulebase Diagram E‘ﬂ&g
Rulebase Type
Select Rulebase Type
Rulebase Type*® [Valli.d.atmn -1
Initialization
Validation
Search
Other
Gdsn
MassUpdate
® (e e ]

5. Select the Rulebase Type from the drop-down list. Click Next.
6. The Rulebase diagram for the newly created rulebase is displayed.

s default.rul 53

[ peclare variahles [E] Declare Constraints

wlm con_rew

Importing Users and Roles

Importing of Users and Roles is an online activity.

Procedure

1. Right click the Rulebase Models folder in the Project Explorer and click Import. Select Import CIM
Users and Roles under MDM Rulebase Designer. Click Next.
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L'/

Select

Import MDM Users and Roles, E — 5 I

Select an import source:

type filter text

» = General

» [= Business Object Modeler B

> [= Business Process Management

= CVS

» = Install

> [= MDM Data Source Designer

> [= MDM Process Designer

> [= MDM Repository Designer

4 [= MDM Rulebase Designer
|i| Import MDM Users and Roles
|i| Import Rulebase N

> [= MDM Synchronization Format Designer

> [= Plug-in Development

> [= Run/Debug

. (3 Service Renictnr -

»

@ < Back Next » Finish

2. Import users, roles or both by selecting the related checkboxes. Browse to select the associated
Project. Click Next.
_ioix

Select CIM Data Type

Please select data to import,

Irnpork Data Type

’7|_ Impart Users r Import Roles ‘
Associated Project

’7Project: |Rulebase Model Samples Browse. .. |

(7 < Back | fext = | Fimish I Canicel |

3. Select the MDM Server from the drop-down list of defined servers. Click Next.

If you opted to import only roles (and not users), skip directly to Step 7.

RI=TE
Select CIM Server

Select a CIM server from the list of defined servers,

CIM Server LI

% Server Details:

Connection URL: 10,97,97,134:9151 Enterprise: ac

User Mame: admin

(7 < Back I Next = I Fimish | Canicel |

4. This dialog can be used to filter user information for retrieval, for example, if you specify First

Name as A, all users with A in the first name will be displayed in the next screen. Optionally, leave
this screen blank (to display all users) and click Next.
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#™ Import CIM Users and Roles gl =|
User Filter Information
Please select users for import,
Username I j
First Mame I j
Last Mame I j
(7) < Back. I Mext = I Finiish | Cancel |

If you left the previous screen blank, all applicable users will be displayed here. If you provided
some filter criteria in the previous screen, users that match that criteria will be displayed. Select the
checkboxes of users to import and click Next.

#™ Import CIM Users and Roles gl =|
User Listing.
Please select users for import,
[T select Al
Lsername | Firsk Marmne | Lask Mame
O & steward steward steward
D 8 Repositary Repositary Approver
D 8 tesk tesk user
O & admin admin admin
(7) < Back. I Mext = I Finiish | Cancel |

6. Selected users are displayed for confirmation. Click Next.

If you selected to import both roles and users but do not want to import roles at this point, click

Finish instead of Next.

#™ Import CIM Users and Roles

User Selection Summary

Selected users will be imported,

=0l x|

Lsername | Firsk Marmne | Lask Mame

& steward steward steward

8 Repositary Repositary Approver

(7) < Back. | Mext = | Finish I Cancel |

7. Next, enter information for the role to import or leave this screen blank and click Next to see all
available roles.
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Role Filter Information

Please enter filker criteria to get roles list,

Role Mame I | j

D

(7) < Back I et = I Fimish | Canicel |

8. Alist of applicable roles are displayed for selection; select the appropriate checkboxes and click

Next.

#™ Import CIM Users and Roles gl =|

Role Listing

Please select roles For import,

[T select Al
Role MName | Description |
D @Work Supervisar Persons having supervisory access
D ﬁsSupport Engineer Persons having Support access
D %Repository Approver Repository Approver
a ﬁsData Steward Data Steward
a ﬁsndmin Default Administrator Role
O %Repository Editor Repository Editor
O ?_\;sExternal User External User

@ < Back I Mexk = I Finiisti | Cancel |

9. Selected roles are displayed for confirmation. Click Finish.

Result

#™ Import CIM Users and Roles gl =|

Role Selection Summary

Selected roles will be imported.,

Role MName | Description |
@Support Engineer Persons having Support access
ﬁsWDrk Supervisar Persons having supervisory access

@ < Back | Iexk = | Finish I Cancel |

You will get a message confirming import of roles and/or users.

37
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Variables

(Short Description to be added).

This chapter explains different kinds of variables, properties, and declaration.

Types of Variables

e User Defined Variables

e Implicit Context Variables

User Defined Variables
User defined variables can be of two types: Data-type and Link-type.

To create a standard variable, use the data-type variable. To create a link to another object, use the link-
type variable.

Data-type variables

Use this type to create a standard variable that is not defining a relationship to or attempting to access
another object.

Link-type variables
Use this type to create a variable that accesses related objects during rule execution.

Links can be of different types:
¢ Relationship Record: Has a relationship and record attribute associated with it and points to a

record defined by the relationship. It follows the relationship to the target record and retrieves an
attribute value (if specified) or the whole record.

¢ Multi Relationship Record: Has one or more relationships and record attributes and points to
records obtained by following a chain of relationships.

¢ Relationship: Has a relationship and relationship attribute associated and is used to access
relationship specific attributes.

¢ Record: Points to a list of catalog product objects.

» Catalog: Used to write SQL statements to access Repository tables.

e Datasource: Used to write SQL statements to access Datasource values.

e Classification: Used to access classification scheme objects and its details.

e (lassification Code: Used to access classification codes and its details.

Implicit Context Variables

These variables are listed in the Rulebase Data View and can be dragged-and-dropped in the
Expression Editor and used without explicit declaration (implicitly).

Most of these variables are available in specific contexts, for example, workitem variables will be
available if your rulebase is executing in a workflow.

¢ Session Variables
e Workitem Variables

¢ Synch History variables
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e System Variables

e Other Variables

e Workflow Variables

e Attribute History Variable
e Attribute Quality Variables

¢ Precedence Result Variable

Session Variables
Session variables are used to access values of system attributes of records.

[, Rulebase Data 23 EEDeploymentSﬂ =0
SEE-BfH e

type filter text

i+ %7 Classification -

4 = Variables

4 JC SESSION
JC COUNTRY
3JC DATE
JC ENTERPRISE_INTERMAL_MAME
JC ENTERPRISE_NAME
I LANGSEL
JC LANGUAGE
JC ORGANIZATION_MAME
JC ORGANIZATION_TYPE
JC ORGANIZATIONID
JC TIMESTAMP
JC USERID
JC USER_ROLES

& [ WORKITEM

P T Y AT R 2 a1 12

m

Session Variables

Variable Type Value

COUNTRY String Users Profile’s Country locale value.

DATE Date Current date.

ENTERPRISE_INTERNAL_NAME String Enterprise Internal Name.

ENTERPRISE_NAME String Enterprise Name.

LANGSEL String Language locale selected from login
page.

LANGUAGE String Users profile’s Language locale
value.

ORGANIZATION_NAME String Organization Name.

ORGANIZATION_TYPE String Organization Type.

ORGANIZATIONID Number Organization Identification number.

TIMESTAMP Timestamp Current Date and Time.
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Variable Type Value
USER_ID String User ID of current user.
USER_ROLES Array Roles the user belongs to.

Workitem Variables

Each step in the workflow has dependent criteria, and requires specific variables to be defined.

The following table lists variables, their types, and values.

iE) Rulebase Data 3 [ Deployment s 8
l ploy!
& BB B =

type filter text

4 = Variables -
> X SESSION
4 [[¥] WORKITEM|
[¥] ACTIVITY_NAME
2] Custom™
[#] DOCSUBTYPE
[¥] DOCTYPE =
[#] ERRORS
[¥] INTENT
[¥] MARKETPLACE_NAME
[¥] MASTER_CATALOG_NAME
[¥] MASTER_CATALOG_VERSION
(] RECORD_COUNT
[¥#] REJECTIONS
[ SEVERITY
[#] STEP_SEVERITY
[#] SUCCESS_COUNT
[¥] TRADING_PARTNER
[¥] TRADING_PARTNER_TYPE
[¥] WARNINGS
> K3 SYNCH_HISTORY

W CL e

m

Workitem variables

Variable Type Value

ACTIVITY_NAME String Current activity name.

SEVERITY Number Workitem severity.

STEP_SEVERITY String Step severity.

DOCTYPE String Document Type that created workitem.
DOCSUBTYPE String Document Sub-Type that created workitem.
ERRORS Number Number of errors in record bundle.
WARNINGS Number Number of warnings in record bundle.
REJECTIONS Number Number of rejections in record bundle.
TRADING_PARTNER String Trading Partner Name.
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Variable Type Value

TRADING_PARTNER_TYP  String Trading Partner Organization Type.

E

MARKETPLACE_NAME String Marketplace name.
MASTER_CATALOG_NAME  String Name of the master catalog of the record

being processed.

MASTER_CATALOG_VERS  Number Master catalog version.

ION

INTENT String Intent passed in to WorklItem activity.
RECORD_COUNT Number Total number of records in the bundle.
SUCCESS_COUNT Number Number of records with no errors.

Custom* String Any Parameter starting with "Custom" that is

passed to Workitem Activity.

Synch History variables
Synch history variables are used to access record synchronization history.

These variables are active only during synchronization.

bype filker bext

= (= Rulebase Domain Objects -
B2 Domain Objects

(= Functions

== Yariables

E-XC sESSION

[-(«] WORKITEM

E-80Y) SYNCH_HISTORY

3% BCCEPT_FLAG

-5 ADD_FLAG

-5 BUYER_ID

50, BUYER_NAME

30 CANCEL_FLAG

-4, COMFIRM_OPERATION_REQUESTED
-4, CORRECTION_FLAG

50, DATAPOOL_ID

50, DATAPOOL_NAME

Synch History variables

Variable Description

IS_DISCONTINUED Is Discontinued

IS_ADDED Is_Added

HAS_BASE_ATTRIBUTE_SET_CHANGED Has_Base_Attribute_Set_Changed

HAS_ATTRIBUTE_SET CHANGED Has_Attribute_Set_Changed
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Variable Description

HAS_PARTNER_ATTRIBUTE_SET_CHANG
ED

Has_Partner_Attribute_Set_Changed

42

IS_PUBLISHED

Is_Published

IS_PUBLISHED_TO_ANY_PARTNER

Is_Published_To_Any_Partner

IS_LINKED

Is_Linked

IS_DELETED

Is_Deleted

IS_REVIEWED

Is_Reviewed

IS_ACCEPTED

Is_Accepted

IS_REJECTED

Is_Rejected

IS_SYNCHRONIZED

Is_Synchronized

HAS_PUBLISHED_RELATION_CHANGED

Has_Published_Relation_Changed

HAS_LINKED_RELATION_CHANGED

Has_Linked_Relation_Changed

HAS_CHILDREN

Has_Children

HAS_PREVIOUSLY_PUBLISHED_PARENT

Has_Previously_Published_Parent

HAS_ANY_CHILD_CHANGED

Has_Any_Child_Changed

HAS_INPROGRESS_SYNC_EVENT

Has_Inprogress_Sync_Event

IS_ROOT_RECORD

Is_Root_Record

IS_PARENT

Is_Parent

IS_CHILD

Is_Child

IS_ADD_REQUESTED

Is_Add_Requested

IS_CORRECTION_REQUESTED

Is_Correction_Requested

IS_DELETE_REQUESTED

Is_Delete_Requested

IS_PUBLISH_REQUESTED

Is_Publish_Requested

IS_RELOAD_REQUESTED

IS_ RELOAD_REQUESTED

IS_CANCEL_REQUESTED

Is_Cancel_Requested

IS_DISCONTINUE_REQUESTED

Is_Discontinue_Requested
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Variable Description

IS_INCREMENTAL_REQUESTED Is_Incremental_Requested

IS_ACCEPT_REQUESTED

Is_Accept_Requested

IS_REJECT_REQUESTED

Is_Reject_Requested

IS_REVIEW_REQUESTED

Is_Review_Requested

IS_SYNCHRONIZE_REQUESTED

Is_Synchronize_Requested

VALID_NEXT_OPERATIONS

Valid_Next_Operations

OPERATION_REQUESTED

Operation_Requested

MASTERCATALOG_ID

Mastercatalog_Id

MASTERCATALOG_NAME

Mastercatalog_Name

BUYER_ID

BUYER_ID

BUYER_NAME

Buyer_Name

TRADING_PARTNER_ID

Trading_Partner_Id

TRADING_PARTNER_NAME

Trading_Partner_Name

TRADING_PARTNER_TYPE

Trading_Partner_Type

DATAPOOL_ID

Datapool_Id

DATAPOOL_NAME

Datapool_Name

INCREMENTAL_FLAG

Incremental_Flag

RELOAD_FLAG

Reload_Flag

ADD_FLAG

Add_Flag

CORRECTION_FLAG

Correction_Flag

DELETE_FLAG

Delete_Flag

PUBLISH_FLAG

Publish_Flag

CANCEL_FLAG

Cancel_Flag

DISCONTINUE_FLAG

Discontinue_Flag

ACCEPT_FLAG

Accept_Flag
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Variable Description

REJECT_FLAG Reject_Flag

REVIEW_FLAG Review_Flag
SYNCHRONIZE_FLAG Synchronize_Flag
CONFIRM_OPERATION_REQUESTED Confirm_Operation_Requested
ROOT_ADD_OPERATION Root_Add_Operation
ROOT_LINK_OPERATION Root_Link_Operation
ROOT_UNLINK_OPERATION Root_Unlink_Operation
ROOT_PUBLISH_OPERATION Root_Publish_Operation

System Variables

System Variables

Variable Description

STATE Gets the product state of the current record.

RECORD_VERSION Gets the product version of the current record.
RECORD_ACTION Gets current record action of the record.

RECORD_CHECKSUM Gets current record checksum.

RECORD_LAST_MODIFIED_ON Gets current record last modified time.
RECORD_CREATED_DATE Gets current record creation date.

RECORD_ACTIVE_FLAG Gets current record active flag.

RECORD_LAST_MODIFIED_BY Gets modify member ID of the member who modified current

record in last.

RECORD_KEY Gets internal bundle key. Contains product key ID and catalog ID.
RECORD_ID Gets record ID for the current record.

RECORD_IDEXT Gets productkey ID and Ext for the current record.

RECORD_KEYID Gets ProductKey ID for the current record.

CATALOG_NAME Gets the name of the catalog for the current record.
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Variable Description

RECORD_IS_ROOT Gets information on whether the record is the root of the bundle.

These variables are used to access values for system attributes of records.

Other Variables

W EEYE S o

i+ (€8] SYSTEM |
4 |[= Other
JC CHILD
JC CONTEXT_CLASSIFICATIONCODE.PATH
JC CONTEXT_RELATIONSHIP.ISFORWARD
JC CONTEXT_RELATIONSHIP.NAME
JC CONTEXT_RELATIONSHIP.REVERSENAME
JC CONTEXT_RELATIONSHIP.TYPE
JC PARENT
JC PREVIOUS_CONFIRMED_VERSION
JC PREVIOUS_VERSION
JC RECORD_ACTION
JC RECORD_IS_BOTTOMMOST
JC RECORD_IS_TOPMOST
JC RECORD_SUB_ACTION
> X WORKFLOW —

. @ . meeo 2

Child

m

e

This variable allows to access attribute values of child record during relationship catalog rulebase
execution. This context variable is only available in relationship catalog rulebase execution. The parent/
child record is always determined in context of forward relationship.

Context Classification Code Path

This variable is used to get the classification code path in context with current record.
Context Relationship IS Forward

This variable specifies whether the relationship is a forward relationship in context with current record.
Context Relationship Name

This variable is used to get the relationship name in context with current record.
Context Relationship Reverse Name

This variable is used to get the reverse relationship name in context with current record.
Context Relationship Type

This variable is used to get the relationship type in context with current record.

Parent

This variable allows to access attribute values of a parent record during relationship catalog rulebase
execution. This context variable is only available in relationship catalog rulebase execution. The parent/
child record is always determined in context of forward relationship.
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Record Sub Action

Currently, the only possible value that can be assigned to this variable is RESTORE. When a record is
restored, for all Ul based rulebase validations for restored record, RECORD_SUB_ACTION is set to
RESTORE. RECORD_SUB_ACTION is bound to RESTORE only for Ul based validations and not
during workflow processing.

Previous Version and Previous Confirmed Version
You can access unconfirmed and confirmed record versions with two explicitly defined contexts.

Previous Version and Previous Confirmed Version

Context Description

PREVIOUS_VERSION Latest confirmed or unconfirmed version.

PREVIOUS_CONFIRMED_VERSION Last confirmed version.

Record Action

This variable is set during Record Add, Edit, or Copy functions.

Record Action
ADD New record is being added.
EDIT Existing record is being edited.
COPY New Record is being copied from another record.
VIEW Record is being viewed.

Record is Topmost

This variable allows you to check whether the record is the topmost in the hierarchy.
Record is Bottommost

This variable allows to check whether the record is bottommost in the hierarchy.

Workflow Variables

Workflow variables are used to access values of workflow.
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[, Rulebase Data 27 . [ Deploymentsw =0

W @SB <

type filter text

i+ ¥7 Other B
[ :)7 Classification

4 = Variables
1 JC SESSION
3 WORKITEM
1 %% SYNCH_HISTORY
i [EB SYSTEM
[» [ Other
a4 JC WORKFLOW

|AC ACTIVITY_NAME |

i JC ATTRIBUTEHISTORY
i JC ATTRIBUTEQUALITY
> JC PRECEDENCERESULT
I> ’Rx User Defined

4 [= Templates E|

Workflow Variable

Variable

ACTIVITY_NAME String Activity Name.

Attribute History Variable

Attributes history variable is used to access the attribute history.

() Rulebase &3 . [ Deploymw =0

S ES-BEHCD
type filter text

4 = Vanables -
b JC SESSION
[ WORKITEM
b Y SYNCH_HISTORY
i |EB| SYSTEM
[ = Other
& JC WORKFLOW |
4 |J¢ ATTRIBUTEHISTORY |
JC CHANGEDATE
JC CHANGEDBY
JC SOURCEID
[ JC ATTRIBUTEQUALITY
& JC PRECEDEMCERESULT
[ *.‘t' User Defined
i = Templates
[=| countFunction T

[ | e | (]
Attribute History Variable

Variable Description

m

CHANGEDATE Date when the attribute values were changed.
CHANGEBY Name of the person who made the change.
SOURCEID Source from where the data came from.

TIBCO® MDM Studio Rulebase Designer User's Guide



48

Attribute Quality Variables

Attribute quality variables are used to access the attribute quality.

E Rulebase Data E-@ % Deployment 5 E
l. ploy )

type filter text

b 3 WORKFLOW -
> X ATTRIBUTEHISTORY
a JC ATTRIBUTEQUALITY
X CHANGEDATEATTR
3 DECAYPERIOD
I DECAVTYPE
3 DECAVUNIT
3¢ IGNOREALWAYS
3 IGNORENULL
IC MAXWEIGHT
3IC WEIGHT
. W PRFCFDFMCFRFSLIT

Attribute Quality Variable

Variable Description

[T

CHANGEDATEATTR Use this attribute as change date instead of system
generated change date.

DECAYPERIOD Period of decay

DECAYTYPE Decay Types. The available types are None,
Linear, Half life.

DECAYUNIT Unit of Measurement of period.

IGNOREALWAYS Always ignore this attribute from this source.

IGNORENULL If value is null, the weight is considered as zero
(0).

MAXWEIGHT Maximum weight.

WEIGHT Weight of the attribute quality.

Precedence Result Variable

Precedence result variable is used to access the result of the precedence.
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2 Rulebase 52 . [{3 Deploym =0
ploy!
S EE-E GO
type filter text

> [#] WORKITEM -
5 &% SYNCH_HISTORY
> (BB SYSTEM
s = Other
> X WORKFLOW
s JC ATTRIBUTEHISTORY
> JC ATTRIBUTEQUALITY =
4 |JC PRECEDENCERESULT
JC ATTRIBUTENAME
X NEWCOMPUTEDWEIGHT
JC NEWSOURCE
JC NEWVALUE
3 OLDCOMPUTEDWEIGHT
X OLDSOURCE
X OLDVALUE

) Wy User Defined _ =
EE n | [t

m

Precedence Result Variable

Variable Description

ATTRIBUTENAME The name of the attribute for which precedence is
defined.

NEWCOMPUTEDWEIGHT The new computed weight.

NEWSOURCE Source from where the data came from.

NEWVALUE The attribute’s new value.

OLDCOMPUTEDWEIGHT The Old computed weight..

OLDSOURCE The name of the previous source.

OLDVALUE The attribute's previous value.

Declaring Variables

The Declare Variables compartment in the Rulebase diagram is used to declare variables for the
rulebase.

A single rulebase contains a single Declare Variables compartment; any number of variables can be
created in this compartment.
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<NO TYP;I . Palette

|E & )

@ Declare Wariables (= Declare Yariables
@\- Drata-type

=l Link-type

(= Dedlare Constraint
l'-'@ﬂ Constraint

Through the Palette

Variables can be created by clicking the appropriate icon (Data-type or Link-Type) in the Declare

Variables section of the palette and then clicking in the Declare Variables compartment in the
Rulebase diagram.

Through the Project Explorer

Variables can also be declared from the Project Explorer view.

L™ *Project Explorer &3 =0

05 9~

A *default.rb 52

@ RETest
E@ Rulebase Model Samples
1-{E) Repository Models
: EHE, Rulebase Models
Bl defaulrb
E@ rule

|E| Declare Constraints

: "ﬁfa dernoallaction
-2 RulebaseTest

type Variable

Ty Linkkype Yariable

=] Show Properties View

L

To do this, expand the Rulebase Models folder, then expand the .rul rulebase file and the rule under
it, and right click the Declare Variables node.

A dialog is displayed for variable creation with content similar to the Properties Tab (see Variable
Properties).

Bl Declare ¥ariable x|
Declare Data-type Variable

Create a new data-type variable.

* Name: Ivar

H @
i

Usage: IRagu\ar

Datatype: | String

Editing Variables

The following can be done from the Declare Variables compartment.

Copy and paste variables: To make a copy of a variable, select a variable and press Control+C and

then Control+V to make a copy of it. Or select a variable, right click it, select Edit > Copy and then
right click in the Declare Variables compartment and select Edit > Paste.
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Reorder variables: To reorder a variable, select a variable and drag to reorder its position within the
variable declaration compartment.

Delete variables: To delete a variable, select it and press Delete on the keyboard. Or select a
variable, right click it and select Delete from Model.

Variable Properties

Clicking a variable (in the Declare Variables compartment) displays its details in the Properties Tab.

Properties for Link type variables
The following details are displayed in the General tab and can be edited:

@)

=] Properties &% m.L Problems QlError Log ] | =

=% ADDRESSCATALOG

General

* Mame: ADDRESSCATALOG
Advanced L
Usage: Local i E
* Link type: Catalog i
* Literals: Type Literal
Repository ADDRESS
Record State COMNFIRMED

Name: Names are case insensitive and cannot contain spaces and special characters (such as -,+,/,
\%).
Usage: Describes the type of variable. Usage can be:

— Input: Input by a user.

— Local: Assigned through a rulebase.

—  Output: Local variable exported to caller.

— Regular: From a catalog or session.

Linktype: Link type of the variable (datasource, record, relationship, and so on)

Literals: Literals are references to meta data (repository or datasource) which are bound to declared
variables. For Catalog link type, the record state is also displayed whether CONFIRMED or
UNCONFIRMED.

Properties for Data type variables
The following details are displayed and can be edited:

Name: Names are case insensitive and cannot contain spaces and special characters (such as -,+,/,
\%).
Usage: Describes the type of variable. Usage can be:

— Input: Input by a user.

— Local: Assigned through a rulebase.

—  Output: Local variable exported to caller.

— Regular: From a catalog or session.

Datatype: Data type of the variable (string, boolean, number ,etc)

Variable references: Displays variable usage details.
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Constraints

A constraint contains a condition and an action. The condition describes when the rule needs to be
applied.

The action describes what the rule actually does and controls what attributes the rule is applicable to.

The Declare Constraints compartment is a default part of the Rulebase diagram.

Adding Constraints

Constraints can be added by clicking the &fa Constraint

Constraint icon in the Declare Constraint section of the Palette and then clicking in the Declare
Constraints compartment of the Rulebase Diagram.

Editing Constraints

The following can be done from the Declare Constraints compartment:

e Copy and paste constraints: To make a copy of a constraint, select a constraint and press Control+C
and then Control+V to make a copy of it. Or select a constraint, right click it, select Edit > Copy and
then right click in the Declare Constraints compartment and select Edit > Paste.

* Reorder constraints: To reorder a constraint, select a constraint and drag to reorder its position
within the Declare Constraints compartment.

& ‘ The order of constraints is of significance since constraints are executed sequentially.

e Delete constraints: To delete a constraint, select it and press Delete on the keyboard. Or select a
constraint, right click it and select Delete from Model.

Constraint Properties
Click an added constraint to see its properties in the Properties Pane.

The following properties are displayed for constraints in the Properties Pane, General tab:

e Name: Any logical name to identify the constraint.
e Description: A short text description of the constraint.

e Use for Variables: This specifies which attribute(s) the rule applies to.
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= pechre variables [E] Declare Constraints

=3 CONTAINSLINK fr Cnt_AssignAction1

m

fr Cnt_AssignAction2
#fr Cnt_CheckaAction
RI[;\Cnt_Prp rulebase and inline Act...

i ont Arraccartinn

E= Properties 52 [ Problems €] Error Log ¥ Data Source Explorer = ¥ =0

f» Cnt_AssignActionl

General

Advanced

* Mame: Cnt_AssignActionl

* Description: assign generated ID to PRODUCTID

m

Use for [ SelectAll Var =
variables:
PRODUCTID
PRODUCTIDEXT
CONTAINS -

m

The following properties are displayed for constraints in the Properties Pane, Advanced tab:

e Active: Indicates the active constraint to be evaluated during rulebase execution. To disable the
contraint, uncheck the active flag.

e Parallelize: Indicates that this constraint does not depend on order of execution and can be executed
in parallel with other constraints in rulebase.

| Properties i . Problems| €] Error Log Data Source Explorer g ¥ =0
wfr Cnt_AssignActionl

General Active: Parallelize: ]
Advanced

Double click a constraint in the main rulebase diagram to open up the Constraint diagram which lists
Conditions and Actions. For details see, aExpressions and Access Action.

Conditions
The condition compartment in your rulebase design allows definition of expressions for the constraint.
Use the palette to add expressions in the condition compartment.

Conditions contain:

» Expressions: The actual expression logic.
* Group Expression: Expressions grouped together.

e Link Expressions: AND and OR operators to connect expressions and group expressions.
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@ Condition

B Expression ‘ K i B Expression2
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Working with Decision Tables

However, the condition values may vary from constraint to constraint.

The decision table allows you to manage scenarios where rules and condition templates are same, only
values of the conditions changes. Decision table defines a tabular format structure similar to a Microsoft
Excel sheet. Each row in the decision table represents a rule. The columns in the decision table are
divided into conditions column and actions column. The actions in the action columns are same as the
rulebase action.

The decision table is created in an existing rulebase file and then configured with the respective
properties. The decision table configuration involves:

e Setting up the name and description

e Setting up the number of rows initially required

e Setting up the number of action columns required

¢ Defining and selecting the condition columns and operators

¢ Reordering the condition columns

Create a Decision Table

The process of creating a Decision table is same as creating Constraints. The Decision table is created in
the Declare Constraint container.

After creating the Decision table their properties are defined. The mandatory fields in the properties
section are denoted by asterisks. The decision table properties are as follows:

¢ Name: While creating the decision table a default name Dt, Dt1, Dt2, and so on is automatically
populated. When a decision table is created for the first time the first instance in the constraint
container has the name as Dt, the second instance has Dt1, the third instance has Dt2 and so on. The
Name field is mandatory.

* Description: The decision table description is also populated with default description Dt, Dt1, Dt2,
and so on. When a decision table is created for the first time, the first instance in constraint container
has the description as Dt, the second instance has Dt1, the third instance has Dt2 and so on.

¢ Rows: The number of rows which should be available initially in a decision table is defined in the
Row field. By default, it displays 1. There are two ways to add or delete rows in decision table. The
number of rows field in the property section can be updated multiple times. Also addition or
deletion of rows is done using the decision table editor. The Rows field is mandatory.

e Actions: The number of actions columns required in the decision table are defined in the actions
field. By default, it displays 1. Maximum of ten action columns can be defined in a decision table.
The actions column numbers can be updated at any time. If the updated action column number is
less than the previously mentioned action column a warning message informing you that some of
the existing actions columns would be deleted is displayed. The Actions field is mandatory.

e Columns: The condition columns for the decision table are defined in the columns field. The
columns field is divided into three sections Select All, Vars and Operators. The check boxes are
displayed in front of Variables for selection. Select the check boxes corresponding to the variables in
the decision table.

Creating a Decision Table

Procedure

1. Select the EEE, DrecisionTable
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icon from the Declare Decision Table section of the Palette and click in the Declare Constraint
compartment.

[ *Project Explarer &2 = O | [afs *newrecardl £2

=R i Repository : PERSON
= & veme ~ HAE =
= 5 Rulebase Models

(& Classification 5/ Declare Variables [E] Declare Constraints

E rs:g catelogralidatian A varl Al rchude newwecord_erbed o Linkstype
il T connectsample.rul

Al 3 paletts

#-413 disconnectsample.rul
@ s embedt.rul
& &g embedz.rul
#-413 embed3.ul

Dt
& #{fp Constraint

(2= Decare Decis,

=0
3

(= Declare Variables <

P — | (= Declare Constr,., <

W

& s newrecord_embed.rul FB, DecisionTable

= &5 newrecord.rl
812 New Record Yalidations
@ it queryancthercatalog.rul
[ sdsn
[ MassUpdate
4] Search
& Al catalogvalidation.rul
- Mew.rul
&3 Ruled.rul
# 7 Business Objects
[ Datasources = @

< bd

[ Deployment Serv |[R} Rulebase Data¥ 53 = O || = Proerties &3

$ESE B Decision Table Type Dt

type filter text General e o

= (= Rulshase Domain Objects ~

= = Domain Objects Description: ot
f- 0 Datasources
- B Repositories
-3 Roles
B8 Users

= (= Operatars
¥ Math
- #= Relational

= (= Functions
B Comparison
& %y Math v * Columns

* Rows 1

* Actions 1

The properties for the newly created decision table are displayed in the Properties section.

E Properties &2

ES Decision Table Type Dt

General * Name: ot
Description: Dk
* Rows 1
* Actions 1
* Columns T

Enter the appropriate Name in the Name field. By default, the name field is pre-populated as Dt,
Dtl, Dt2, and so on. You can change the name as required. The Name field is mandatory.

Enter the appropriate description in the Description field. By default the description field is pre-
populated with Dt, Dt1, Dt2, and so on. You can change the description as required.

Enter the number of rows required in the decision table in the Rows field. By default, the Row field
displays 1 row. The rows can be appended using the decision table editor. If the number of rows
mentioned in the Row field becomes less than the existing number of rows in the decision table
editor, a message is displayed. If you decide to delete the rows, excessive rows in the decision table
editor are deleted starting from the last row. The Rows field is mandatory.

Enter the number of actions column required in the decision table in the Actions field. By default,
the Action field displays 1 action column. The decision table can have maximum of ten action
column. If you decide to delete the action column, for example, if the number of action column is
less than the previously mentioned action column, a message is displayed before deletion. The
Actions column field is mandatory.

Select the appropriate condition columns for the decision table from the Columns field. By default,
the first row is selected. Select the checkbox corresponding to the variables which should be part of
the decision table. Select the appropriate operators to associate it with the selected variables. Based
on the combination of Variable name from Vars column and operator image from Operators
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column the decision table column title is displayed. The conditions column is divide into three sub
columns namely Select All, Vars and Operators.

Select All:

The Select All sub column is used to select the entries that would appear as columns in the
decision table. Check/Uncheck the checkbox to select and clear the selections. If you want to
select all the checkboxes, check the Select All checkbox in the header. After the selection, if you
try to uncheck the Select All checkbox, a warning message is displayed and all the checkboxes
are cleared except for the first row checkbox. After selecting the checkbox, if you try to uncheck
it, the following message is displayed This will delete column data for all the rows? Would you
like to Proceed?

Vars:

The variables appearing in the Vars sub column are derived from the repository that is linked
to a given rulebase file and from Declare variable container in the rulebase file. The session
variables are also displayed.

& The variables with File data type and Link Type variables are not included in the
Vars sub column.

Operators:

The Operators sub column is used to associate a particular operator with a given variable in
the Vars sub column. The Operators sub column provides a list of various operators. The
operator listing varies depending upon the data type of the variable in the Vars sub column
and whether variable is multi-value attribute or not. For more details on Operators, refer
Operators.

After the variables and operators are defined, you can change the order of the condition columns.
To change the order of the conditions columns, select an entry in the row and change the order by

clicking the up arrow ”'} icon or the down arrowﬂieon.

10. Click Save.

Operators

While defining the condition columns in the decision table you need to associate a particular operator
with a given variable.

The Operators column provides a drop-down list which contains various operators. The operator
listing varies depending upon the data type of the variable in the Vars column and whether variable is
multi-value attribute or not.

The following operators are available in the drop-down list:

Eq (equals)

Neq (not equals)

Gt (greater than)

Geq (greater than or equal to)
Lt (less than)

Leq (less than or equal to)

In

Bet (Between)

Contains

Contains All
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¢ Custom

Data Type - Operator Listings

Data Type - Operator Listings

Variable Data Type Supported Operators

String In, Eq, Neq, Custom

Number In, Bet, Eq, Neq, Geq, Gt, Leq, Lt, Custom,
Boolean Eq, Neq, Custom

Date In, Bet, Eq, Neq, Geq, Gt, Leq, Lt, Custom,

For multi-value attribute, following operators are supported

¢ Contains

¢ Contains All

. Eq
* Neq
¢ Custom

Custom Operator

If the available operators do not suffice the need, the custom operator can be used. The custom operator
contains custom conditions which you can configure.

On selecting the custom operator the custom condition parameters are displayed.

[ Propetties £2 . (3! Problems| @] Error Log| &~ =08
E% Decision Table Type Dt
S - = —
General el
* Actions il =
* Columns  seectAl Vors Operators < | @ | Custom Condition Parameters
SESSION/USER ID Custor Package Name
SESSION/USER_ROLES =t
SESSION/ORGANIZATION_N.. = Eq @ @ * Operator Class
SESSION/ORGAMIZATIONID = Eq e
] SESSION/ORGANIZATION_TY... = Eq |_
& SESSION/ENTERPRISE NAME = Eq | Comparators ane he
] SESSION/ENTERPRISE INTER... = Eq
] SESSION/COUNTRY =
] SESSION/LANGSEL =
=] SESSION/LANGUAGE =E -
« i '
E]

Enter the Package Name, Operator Class Name and select the Comparator from the drop-down list.
The comparators are as follows:

e Boolean Comparator

e String Comparator

e Date Comparator

¢ Number Comparator

e MYV Comparator

* None

¢ Custom
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The Boolean, String, Date, Number and MV are the existing comparators. If you do not want to provide
any comparator, select the None comparator. If you want to want customize and provide your own
comparator, use the custom comparator. Enter your comparator in the custom value field.

Cuskom Condition Parameters

B * Class Name
Package Name
Comparators 2

@ * Cuskom Value

Decision Table Editor

Once you have created the decision table and configured the properties of the decision table, it is time
to use the decision table.

On double clicking the newly created decision pallet, it opens the decision table editor.

The decision table editor Ul appears similar to Microsoft Excel sheet.

sza rizrecord. rul E'a nevrecord rul#DE £5 =0
4 E | o E
Conditions Actions
firstname = |aga = DATEOFEIRTH = |MARRIED = Actionl
Jnhn 136 03-09-1975 v (Dage
Insert Row Above
Insert Row Below
Duplicate
Move Row Above
Move Row Below
Delete Row
] Properties &2 IL Problems _O__I Error Log ¥ =0

The decision table displays the Conditions and the Actions columns. Each variable along with the
operators symbol is displayed in the Conditions section. The Action section list the actions column
configured during creation of decision table. By default, the number of rows displayed are as per the
rows configured in the property section.

To add more rows to the decision table, select the row and right-click mouse. The following actions are
displayed:

¢ Insert Row Above: Insert a row above the selected row.

¢ Insert Row Below: Insert a row below the selected row.

¢ Duplicate: Insert a duplicate row.

¢ Move Row Above: Move the selected row above the previous row. This is disabled for the first row.
¢ Move Row Below: Move the selected row below the next row.

¢ Delete Row: Delete a row.

Similarly, you can filter and sort the rows.
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Filtering and Sorting Rows

Procedure

1. Select the Header containing the variable name along with operator symbol and right-click mouse.

Click Enable Filter.
%*newrecord.ru\ ﬁ*newrecord‘rul#Dt 3 =0
| a C e P c

Conditions Actions

DATECFEIRTH MARRIED Action1

1 3% 03-09-1975 Bage

2. Double-click on the column header which you want to sort or filter. The decision table displays the
drop-down list with the sort order and the filtering options.

s *newrecard.rul £ =08

LS B i |D E

Conditions Actions

firstname v |age = |DATEOFBIRTH = [MARRED = [action.
Sort Ascending —

|1 [Sort Dascending % 03-09-1975 Bnge

2 |Gan H

—{(Top 10...)

(Custom...)

ohn

(Blanks)

MonBlanks

3. You can sort by ascending or descending order. You can filter by ALL, Top 10, By values, Blanks or
NonBlanks, and by Custom filter. If you select custom filter, a custom Row Filter Dialog box is

displayed.
@ *newrecord.rul e
& % |C |D E
Conditions Actions
firstname age = |DATEOFBIRTH = |MARRIED = Actionl
6 03-09-1975 @age

# Row Filter, Dialog,

Enter Custom Filker criteria (RegEx)

4. Enter the custom filter criteria in the Enter Custom Filter Criteria (RegEx) field. The filter criteria
should be a regular expression.
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5. Click OK.

Cell Validation

Each and every value entered in decision table is validated. If you enter or modify a value in the cell, a
validation check is performed.

In case the validation check fails, cross mark Ed appears in the right corner of the cell. When you
hover over the cross mark, a tool tip with the reason for validation failure is displayed.

ﬂtb‘newrecord.ru\ B3 newrecord rul#nt 3 =0
a |E ‘C |D E

Conditions Actions

firstname = |age = ‘DATEOFBIRTH = |MARRIED = Action!
1 |Iotn £ £ 03091975 Bage

3 is nok & valid number

The following cell validations are performed:

* Syntax Validation -The syntax validation is performed while entering multiple values. A comma
delimiter must be used while entering multiple values.

e Validation of values based on operator - The number of values entered in the text cell for a
particular column depends upon the combination of type of operator used for that column and the
variable (whether its multi-value or not). The table below shows the number of values required for
various operators.

Cell Validation
Number of Values required Number of Values required for Non

Operator for multi-value attribute multi-value attribute
Eq * 1

Contains * NA

ContainsAll NA NA

Customs NA NA

In NA *

Neq * 1

Gt NA 1

Lt NA 1

Geq NA 1
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Number of Values required Number of Values required for Non
Operator for multi-value attribute multi-value attribute
Leq NA 1
Between NA 2

e Validation of values as per the variable data type - After performing the Syntax and number of
values validation, the variable data type validation is performed. The following date type formats
are supported by decision table:

- mm/dd/yyyy (default date format)
- dd-mon-yyyy

-  mm/dd/yy

- ddmmyyyy

—  yyyy-mm-dd

—  yyyy/mm/dd

— dd-mm-yyyy

— dd/mm/yyyy

- dd-mm-yy

— timestamp

Cell Skipping

In decision table, skipping a cell means the condition which is of the form [Variable] [Operator] [cell
Value] is not evaluated for a given row whose cell is skipped.

The cells which are skipped are marked in Yellow.
Skipping a Cell

Procedure

1. Select the cell which you want to skip. For example, select the cell where age=36.

R% *newrecard.rul =0
A B € |D E

Conditions Actions

firstname = |aqe = |DATEOFEIRTH = |MARRIED = Actiont
1 |John 3% 05-05-1575 @gs

2. Right-click on the cell and select Skip. The cell which is skipped is marked in yellow.
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&3 newrecord.rul ES X =g
A |E |C |D E
Conditions Actions
firstname = |aqa =L"I‘I |DATEOFEIRTH = |MARRIED = Actioni
1 |John 36 03-09-1975 = Eage

3. Atany give point of time if you want to include the skipped cell, select the cell marked in yellow,
right-click on the cell, and select Include.

Decision Table Export

Decision table is exported as a part of the rulebase process export. During export, the following files are
generated:

e DT XML file: The DT XML files contains all the conditions defined for each row in the decision
table.

e Actions XML file: The Action XML file contains all the actions defined for each row in the decision
table.

e <rulebase filename>.xml file: This is the main rulebase file.

You can export only those decision tables which do not have any validations errors in it.

Exporting a Decision Table

Procedure

1. Right-click the rulebase file in the Project Explorer and click Export > Export .

L™ Project Explorer 23 =0 ﬁfa newrecord, rul EE-?-» new
BS |67 A s
= ‘_9 demo
{E| Repository Models Firstname = |age
= Rulebase Madsls ;
A - 1 John i36
7 catalogyvalidation, rul -
% catalogvalidation-relationshipattr . rul
% demoallactions.rul
R
3 Mew R e '
[ita searchcon Open E3
= standard Open With N
|| Copy Chrl+C
¥ Delete Delete
Move...
Renare. .. Fz
g Import...

Export L4 ‘@. Archive File
[, rulebase Datavi 22 & Refresh F5
Yalidate
2. The Export Wizard is displayed. Expand MDM Rulebase Designer from export destination list,
select MDM Rulebase Format, and click Next.
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M Export

Select

Export Rulebase

Select an export destination:

|type filter bext |

(= E®

= Java

(= JavaEE

(= Javascript

(= MDM Data Source

(= MDM Pracess Designer

[ MDM Repository Designer

== MDM Rulebase Designer
[ 411DM Rule ormat

(= MDM Synchronization Format

(= Plug-in Development

[ Run/Debug

(= Team

= Weh

(= Web Services

(= wL

ML Ak

>

<

®

Select the rulebase file which you want to export. By default, the rulebase file is exported to /
Exports directory which is in the same project.You can change the location by specifying a different
destination path. Select the Path option and browse to the folder in which you want to export the
rulebase XML file and click Finish.

 CIM Rulebase Designer Export Wizard

CIM Rulebase Designer Export Wizard
Select Concepts For Export ko CIM Rulebase Format

= @3 dema
B[] Rulebase Models
Dfﬁt:,‘“ ratalogvalidation. rul
DEE,‘ catalogvalidation-relationshipattr, rul
I:“Etn"‘ demaallactions . rul
Bk =t newrecord.rul
Dfﬁtn" searchcontralrules, rul
[[] & standard

Select Al [ | Unselect Al

Destination
(*)Project (Location! [Exports)

() Path: ‘

2
The Exports folder in the explorer displays the DT XML, Actions XML, and the <rulebase

filename>.xml files.
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=&l
I Mews Record Walidations
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[= standard
[=-[= Exports
|X| Dt_newrecord_fckions. xml
\X| Dt_newrecard.xml

X newwrecord, xml
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Direct Deploying the Decision Table

Procedure

1. In the Deployment pane, right click the <MDM Serverand select Deploy Module.
2. Select the rulebase module to deploy. Click Next.

_ \
PETTEEE s

Select Modules
Select modules you want to deploy.

Supported Modules:

Project i E
4 @2 UBuilderTutorial
» [] = Process Packages
4 [H = Repository Models
a4 E@O PACModel.rep
4 [H B PERSON
[] — PersonToClient
% default.rul [ M
» [C1BE ADDRESS
» [O]Eg CLENT
» [[] = Rulebase Models I
[Tl = Datasources

m

3\ -
i < back TN > Finis ancel
® v (o [ o | o] |

3. Select the enterprise to deploy the rulebase to (either the current enterprise or standard). Click
Finish.

P Deploy MDM Design Artifact(s)

Enterprise Selection

Select enterprise in which yvou want to deploy modules,

Enterprise Selection
(%) techpubs
() standard

‘alidating repository models. ..

On successful deployment a confirmation message is displayed. Similarly if an error is encountered
and error is displayed.

ﬂ Deployment results 1'

@ Deployment finished. Mo errors were reported,

" Dot show this again

@ QK I Details == |

TIBCO® MDM Studio Rulebase Designer User's Guide



67

Result

Once successfully deployed, you can log onto the MDM Server and check if your decision tables have
got included.
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Expressions

& Expressions are displayed in the Condition section of the Constraint diagram, accessed by double
clicking constraints in the Declare Constraints compartment in the main rulebase diagram.

Expressions in a condition must evaluate to Boolean. Expressions created in the rulebase diagram have
a corresponding property tab, which in turn contains an expression editor.

@ Condition 1

% B Expression % @ i BExpressi0n2‘ L

Els

|

= Properties 53 ["_ Problems} _@_I Error Log}

& Expression
[

General

Expression: definedNAME)

Advanced

|
Creating Expressions

Expressions can be created using the following icons from the Condition section of the Palette and
dropping in the Condition compartment.:

E Expression

» Use this Expression icon to create standalone expressions.

Group Expression

* Use this Group Expression icon to create group expressions.
For details, see Expression Editor Palette.

Group expressions allow for a bracket effect to the expression, for example (a==1 && (b==2 or c==5)).
Group expressions can contain expressions and nested group expressions.

A group expression has two expressions per row and one group expression per row. Use CTRL+SHIFT
+F to arrange the expression appropriately.

@ Condition

GroupExpression

Expression Editor

The Expression Editor provides user friendly expression definition functionality such as content assist,
syntax completion, and syntax coloring (all functions and reserved words are colored).

Select the Expression box (within the condition) in the constraint diagram to see its properties in the
Properties tab. On selecting the expression box, the Properties tab displays an Expression textbox to
add, define, or modify the expression logic.
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Content Assist

Click in the Expression textbox and use the Ctrl+Spacebar keyboard shortcut.

This activates context sensitive coding assistance and displays a list of applicable elements for the
location content assist was activated for.

M@_ Problems} 6_-| Error Log}

B Expression Expression2

]
General Expression:
Advanced 2 defined{variable) 1=
2 undefined{variable)

¢ match{variable, string) e
2 changed(variable, string)

if roundiarray, number, string)
lIB;u|:||:narcase(string)

lIB;n:ual:l(array, number, string)

“;substring(string, number, number’)
lIB;Ipacl(array, number, string)

RBf lengthistring) LI

Use the mouse or the keyboard (Up Arrow, Down Arrow, Page Up, Page Down, Home, and End) to
navigate and select elements in the list. Press Enter on a selected element in the list to insert the
selection into the editor.

You can also drop and drop variables from the Rulebase Data View into the Expression Editor.

E Properties &3 [3_\ Problems} 6_-| Error Log}

[} Rulebase Data ¥iew 23 =0
Expression Expression2
S F BB R pression =
|type filker bext General

Expression:

ENTERPRISE NAME El

Advanced

o]

(== Rulebase Domain Objects
B Domain Objects
+-(= Functions

E‘B ‘Wariables
B SESsIoN

| v

~JC DATE
~JC ENTERPRISE_INTERNAL_NARN

Syntax Errors

An error marker is displayed when there is a syntax error in the expression editor.

Expression: 3 q Syntax Error: <un2xpected: [@4,13:13="", <46>,1:13], resxnc=defined(NAME). =h

Templates

&

Templates are a structured description of coding patterns that reoccur in the expression editor.

The expression editor supports the use of templates to fill in commonly used source patterns.

Templates can be inserted using content assist (Ctrl+Space). Reoccurring expression syntax can be saves
as a template by using the

Save as Template button (to the right of the expression editor). On clicking this button, you will be
prompted to provide a name for the template.

‘ While defining a constant string values use "Single Quote(')" in the expression editor.
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Restrictions on SQL Expressions

The following restrictions apply for the use of SQL expressions:

The following logical expressions are supported: and, or, not, in, defined, undefined, like.
The following operands are supported: eq, neq, leq, It, geq, gt.
You have to use a where clause if you have a table where source is sql.

Multi-column results can only be used in select and slice actions. All other functions require a
single column result (that is, a list of values).

Built-in functions such as concat, count, and so on cannot be used within an SQL expression.

In case of rulebase evaluation with relationship attribute values, the access modifiers on records
based on relationship attribute are not applied on the record list. For example, if you try to hide
some records from a record list based on their relationship attribute value for a particular
relationship, the records are not hidden.

The multi-value attribute can only be used in where clause and not supported in a select column
list.

Only supported operators for multi-value are eq, neq, in and like.
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Actions

&

Actions are displayed in the Constraint diagram, accessed by double clicking constraints in the Declare
Constraints compartment in the main rulebase diagram.

Actions specify what a rule actually does. The action executed depends on whether the condition
evaluates to true or false. Actions can be of two kinds: Then actions and Else actions.

The Constraint diagram contains Then Actions and Else Actions in appropriate Action containers, at
the end of the logic flow.

& actiore
<= AsglLastMame
Then
Else | = asglookupEnum
<= AsgllookupDs
E‘:> Actiors
- (3 CrName
¥ IncSampleRb

=0 (TN

The Actions group in the Palette contains icons for actions that can be dropped in the Then Actions or
Else Actions sections. To define actions, select action icons from the palette and drop it in the Actions
container.

Logic Implemented for Action

The following logic is implemented for Actions:

» If a condition is specified, a THEN Action is mandatory. ELSE Actions are optional.

* THEN Actions are executed if the expressions in the Condition section evaluate to true.

e ELSE Actions are executed if the expressions in the Condition section evaluate to false.

e If an ELSE action is specified, an associated condition is mandatory.

e A THEN Action can be specified by itself without any ELSE Action or associated Condition.

e Action tags (if specified within the Action compartment) are executed sequentially if the condition is
true or if no conditions are present.

e In case of any undefined variables, the condition may not be evaluated and no actions will execute.

Access Action

The Access action provides control over viewing, modifying, and visibility of Attributes, Attribute
Groups and Records.

To define an Access action, select the & arcess

Access action icon from the palette and drop it the appropriate (Else or Then) Action container.
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Access Action Properties

The following properties can be provided for the Access Action in the Properties window, General tab:

'_i g > [‘_Problems}@_lError Log] ¥ =0

@ Access Action

-

General Marne: I Accesshction I—
* Mode: | Hide =]
* fpplies to: I Select... j

Use For Vars
Reelationship
Relationship Attributes oo
Attribuke/AttributeGrp

¢ Name: Any logical name for the Access action.
e (Mandatory) Mode: The Mode controls the visibility and access to a record, attribute, or attribute
group. The following values can be set here:
— View: Attribute/Attribute group will appear in the Ul as read-only.
— Hide: Attribute/Attribute group will not be visible in the Ul
—  Modify: Attribute/Attribute group will be visible in the UI and can be modified by users.
— View Record: Record will appear in record lists but cannot be modified.
— Hide Record: Record will not appear in record lists or relationships.
—  Modify Record: Record will appear in record lists and can be modified.

— Hide Relationship: Hide Relationship is used to hide the relationship from Ul
(RecordHierarchy). This mode works only with relationship catalog validations.

View, Hide, and Modify modes apply for Attribute/AttributeGrp, Use for Vars, Relationship,
& Relationship Attributes.

View Record, Hide Record, and Modify Record apply for records.
¢ (Mandatory)Applies To: This indicates what the Access action applies to. Values are:

—  Attribute/AttributeGrp
—  Use for Vars
-~ Relationship
— Relationship Attributes

& This option is disabled if the selected mode is View Record, Hide Record, Modify Record, Skip Merge,
Allow Merge.
Access Action Validation

If Applies To is set to a value other then Use For Vars, it is mandatory to select the associated
Relationship Type Variable or Attribute Group.

If the associated drop-down is not selected, an error marker with an appropriate error message is
displayed.
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'_i g i ["_ Problems} QI Error Log}
@ Access Action
I
General Mame: I Accesshction
+ Mode: IView j
* Applies to: IReIationship Attributes j
T
a3 * Link Select... j
Relationship I ......................................................................................................................................
Type Variable: [0 Ol st ToAdd/SHIPPING
varlinkRelCust ToAdd/RESIDENCE
warl [CustomerToAddress/RESIDENCE]

ApplyPrecedence Action Properties

The following properties can be provided for the ApplyPrecedence Action in the Properties window.

General tab properties

¢ Name: Any name for the ApplyPrecedence Action, default name is ApplyPrecedence.
¢ Logical Name: Any logical name for the ApplyPrecedence Action.
¢ Rulebase: Browse and specify the rulebase to embed or type the relative path of the rulebase.

* Version: Select the version for ApplyPrecedence Action to identify with which version you want to
compare. The available options are Blank, PREVIOUS_VERSION, and
PREVIOUS_CONFIRMED_VERSION. The default value is blank.

* Explanation: Specify text to be displayed after applying precedence. Dynamic text can be specified
using the place holder and then binding variables in Bind Parameter table.

— To Bind Parameter specify the dynamic values, enter the text with place holders. For example:
Attribute {ATTRIBUTE_NAME} Value {ATTRIBUTE_OLD_VALUE} has been changed to
{ATTRIBUTE_NEW_VALUE}.

— After entering the text, click anywhere on the property section, the Bind Parameters table is
populated with the specified parameters from the explanation text. For example, if you have
entered the following in the explanation text field
Attribute {ATTRIBUTE_NAME} Value {ATTRIBUTE_OLD_VALUE} has been changed to
{ATTRIBUTE_NEW_VALUE}.

e Bind Parameters: The bind parameters table has four fields.

— Parameter:- The name of the parameter is populated from the explanation text.

— Value: Select the appropriate value from the Value drop-down list. The available options are
PRECEDENCERESULT/ATTRIBUTENAME, PRECEDENCERESULT/OLDSOURCE,
PRECEDENCERESULT/OLDCOMPUTEDWEIGHT, PRECEDENCERESULT/OLDVALUE,
PRECEDENCERESULT/NEWSOURCE, PRECEDENCERESULT/
NEWCOMPUTEDWEIGHT, PRECEDENCERESULT/NEWVALUE.
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-] Properties £3 . % Problems| € Error Log Data Source Explorer| & Console = =58

< ApplyPrecedence Action
General Mame: ApplyPrecedence

Logical Mame:  ApplyPrecedence

‘test/Rulebase Models/absquality.rul

Rulebase:
Versien PREVIOUS_VERSION =

Explanation:  Attribute {ATTRIBUTE_NAME} Value {ATTRIBUTE_OLD_VALUE} has been changed to
{ATTRIBUTE_NEW_VALUE}.

n

Bind Parameter Value
Parameters [ s o
ATTRIBUTE NAME PRECEDENCERESULT/ATTRIBUTENAME |

ATTRIBUTE_OLD_VALUE PRECEDENCERESULT/OLDVALUE
ATTRIBUTE_MEW_VALUE PRECEDENCERESULT/NEWVALUE

ApplyPrecedence Action Validation

The following validations are performed at the time of Export.

¢ The rulebase embed path file must have a valid path or empty field.

e Each Parameter must have value assigned to it or parameter value must not have an empty or null
value.

Apply Precedence Action
The ApplyPrecedence action decides when the precedence should be applied.

To define a ApplyPrecedence action, select the 4 appiyPrecedence  icon from the palette and drop it in the
appropriate (Else or Then) Action container. The ApplyPrecedence action can be implemented only if
the precedence management flag is set to true in the repository property section action icon from the
palette and drop it the appropriate (Else or Then) Action container.

ApplyPrecedence Action Properties

The following properties can be provided for the ApplyPrecedence Action in the Properties window.

General tab properties

* Name: Any name for the ApplyPrecedence Action, default name is ApplyPrecedence.
* Logical Name: Any logical name for the ApplyPrecedence Action.
¢ Rulebase: Browse and specify the rulebase to embed or type the relative path of the rulebase.

* Version: Select the version for ApplyPrecedence Action to identify with which version you want to
compare. The available options are Blank, PREVIOUS_VERSION, and
PREVIOUS_CONFIRMED_VERSION. The default value is blank.

» Explanation: Specify text to be displayed after applying precedence. Dynamic text can be specified
using the place holder and then binding variables in Bind Parameter table.

— To Bind Parameter specify the dynamic values, enter the text with place holders. For example:
Attribute {ATTRIBUTE_NAME} Value {ATTRIBUTE_OLD_VALUE]} has been changed to
{ATTRIBUTE_NEW_VALUE}.

—  After entering the text, click anywhere on the property section, the Bind Parameters table is
populated with the specified parameters from the explanation text. For example, if you have
entered the following in the explanation text field
Attribute {ATTRIBUTE_NAME]} Value {ATTRIBUTE_OLD_VALUE} has been changed to
{ATTRIBUTE_NEW_VALUE]}.
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e Bind Parameters: The bind parameters table has four fields.

Parameter:- The name of the parameter is populated from the explanation text.

Value: Select the appropriate value from the Value drop-down list. The available options are
PRECEDENCERESULT/ATTRIBUTENAME, PRECEDENCERESULT/OLDSOURCE,
PRECEDENCERESULT/OLDCOMPUTEDWEIGHT, PRECEDENCERESULT/OLDVALUE,
PRECEDENCERESULT/NEWSOURCE, PRECEDENCERESULT/
NEWCOMPUTEDWEIGHT, PRECEDENCERESULT/NEWVALUE.

] Properties 72 % Problems| &) Error Log | ¥ Data Source Explorer| Bl Console

< ApplyPrecedence Action
General Mame:

ApplyPrecedence -

Logical Mame:  ApplyPrecedence

Rulebase: ftest/Rulebase Models/absquality.rul
Versien PREVIOUS_VERSION

Explanation:  Attribute {ATTRIBUTE_NAME} Value {ATTRIBUTE_OLD_VALUE} has been changed to
{ATTRIBUTE_NEW_VALUE}.

n

Bind Parameter Value

Parameters | —— !
ATTRIBUTE NAME PRECEDENCERESULT/ATTRIBUTENAME |
ATTRIBUTE_OLD_VALUE PRECEDENCERESULT/OLDVALUE
ATTRIBUTE_NEW_VALUE PRECEDENCERESULT/NEWVALUE

ApplyPrecedence Action Validation

The following validations are performed at the time of Export.

The rulebase embed path file must have a valid path or empty field.

Each Parameter must have value assigned to it or parameter value must not have an empty or null

value.

Assign Action

The Assign action allows for assignation of values to variables.

Values can be assigned to declared variables and repository attributes.

To define an Assign action, select the .Z. assign Assign action icon from the palette and drop it in the
appropriate (Else or Then) Action container.

Assign Action Properties

The following properties can be provided for the Assign Action in the Properties window, General tab:

e Name: Any logical name for the Assign action.

Assign: This displays a list of all variables, and provides an expression editor to type the expression.

Select the variable to be assigned in the Assign drop down and specify the expression in the
expression editor to the right of the assigned variable.

ul’_ Problems} O Error Loﬂ

I—

General

Advanced

‘= AsglLookupDs

Mame: I AsglLookupDs

Assign: | PRODUCTIDEXT j =| Jookup(NAME, tableDatasource(D31', PRC 4 | = |
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The expression can be a simple mathematical expression like (a+b*(c+d)) or as complex as assigning an
array {1,2,3} or ({'abc', 'xyz'}, 2) or tableSql({col1,col2}, where coll="John' and col2='D").

If you are assigning a true or false value to a boolean type variable, the value must be written in lower
& case otherwise the assignment does not work correctly. For example, true. This is treated as constant
value assignment.

Advanced tab properties

¢ Level: For details, see Level.
¢ Refresh: For details , see Refresh.

e Priority: For details, see Priority.

] Properties &2 &~ =0

& Assign Action

Genersl Leval: I Priotity: 1 v

Advanced
Refresh: Cumulative:

Assign Action Validation

If the assignment variable (in the Assign drop-down) is not selected and if there are errors in
expression, an error marker is shown on the figure.

Assign Identity Action
The Assign Identity action allows you to identify an external key and map it to the internal key.

If the data that is being imported does not have PRODUCTID and PRODUCTIDEXT, use the Assign
Identity action.

The Assign Identity action can also be used when data is modified from web services or from User
Interface. However, the assign identity rule should only be used when data is being saved for the first
time, that is when MDM has not already assigned an identity and product key to it.

If Assign Identity rule is used during new record creation, and any existing matching record is found,
the add will be rejected as duplicate. The assign Identity rule does not work with SaveRecord activity in

workflow as product ID and Ext are required for this activity to merge the incoming data with existing
data.

To define an Assign Identity action, select the

4 Assign Identity

Assign Identity action icon from the palette and drop it in the appropriate (Else or Then) Action
container.

Assign Identity Action Properties

The following properties can be provided for the Assign Identity Action in the Properties window,
General tab:

* (Mandatory)Name: Any logical name for the Assignldentity action.
* Explanation: A detailed description of the Assignldentity action.

* (Mandatory)Sequence to generate record ID: The Sequence in which the product ID is generated.
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(Mandatory)Identity Attributes: Select the attribute which you want as the business key to uniquely
identify the record. The multi value attribute cannot be specified as business key.

4 Assign Identity Action

General * Name:

Advanced

Explanation:

* Sequence ko
generate record

* Identity Attributes:| PRODUCTID

PRODUCTIDEXT
CONTAINS

narme
ProductCode

Price

category

availability

vendor

Advanced tab properties

e Level: For details, see Level.
¢ Refresh: For details, see Refresh.

e Priority: For details, see Priority.

] Propetties 2

4 Assign Identity Action

General Level: 5 Priority: i v
Advanced

Refresh:

Assign Identity Action Validation

If the Name, Sequence to generate record ID, and Identity Attributes are not selected and if there are
errors, an error marker is shown on the figure.

Categorize Action

This action allows to categorize the record, it can categorize the record in one or more categorizes.

The categorize action supports incremental flag, by default incremental flag value is set to "True".

To define an Categorize action, select the £ Categorize  Categorize action icon from the palette and
drop it in the appropriate (Else or Then) Action container.

Categorize Action Properties

The following properties can be provided for the Categorize Action in the Properties window, General
tab:

* Name: Any logical name for the Categorize action.

Explanation: A detailed description of the categorize action.
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e Incremental: True - to keep record’s existing classification along with the current action. False - to
remove record’s existing classification and to categorize it into provided classification codes in this
action.

e (Mandatory)Expression: Input parameters must be an array of link types classification code or any
expression that evaluates to classification code.
For example, the following are the input parameters for categorize action:
getClassificationCodeByCode(CODEVAR_SOCIAL, 'P07') - This is a classification function that
returns classification code.
CODEVAR_DESKTOP - This is link type classification code.
CODEVAR_DB - This is link type classification code.

4 Categorize Action

General Mame:

Explanation:

Incremental

* Expression:

Categorize Action Validation

If the Expression variable is not specified and if there are errors in expression, an error marker is shown
on the figure.

Check Action

The Check action evaluates an expression as true or false. If the expression is true, the attribute is in
compliance. If it is false, the check failed and an explanation is displayed.

To define a Check action, select the @ check. Check action icon from the palette and drop it in the
appropriate (Else or Then) Action container.

Check Action Properties

The following properties can be provided for the Check Action in the Properties window.
General tab properties

¢ Name: Any logical name for the Check action.
» Explanation: Specify text to be displayed if the expression evaluates to false.
e Information: Information about the check action.

e Expression: Expression that evaluates to true or false.
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= Properties 23 [;_ Prnhlems] @ Errar Lng]
(& ChkForBInkNm
]
General Narme: I ChkForBinkirm
Advanced
Explanation: Zuskomer ‘name’ cannot be blank ;I
-
K| »
Information: ;I
=
Kl »
Expression: | Jength trimMAME)) = & ;I =

Advanced Tab Properties
e Severity: Set the Severity level for this action.

Check Action Validation

If there is an error in the expression, an error marker is shown on the figure.

Clear Action

The Clear action is used to clear a variable. Select the variable to be cleared.To define a Clear action,

select the@ clear Clear action icon from the palette and drop it in the appropriate (Else or Then) Action
container.

Clear Action Properties

The following properties can be provided for the Clear Action in the Properties window.

General tab properties

Name: Any logical name for the Check action.

Variable: Select the variable value to be cleared. Choose from a list of declared variables and repository

attributes.
i__‘Illiiiliﬁ (2l Problems} O] Error LUQ}
® clrName
]
General Marme: I ClMarne
Advanced
* Yariable: MNAME [
varl [link] =

warADDRESSRECORDS  [link]
Copy_1_varlinkCatalogCustomer  [link]
---- " Attributes ----

PRODUCTIC

PRODUCTIDEXT

CONTAINS

FIRSTMAME
LASTMAME

4]

Advanced tab properties

¢ Refresh: Refreshes the variable.For details , see Refresh.
e Priority: For details, see Priority.

¢ Level: For details, see Level.
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__‘H g i [3_ Problems} 6_-| Error Log}

® CclrName

General Refresh: Priority:

Advanced

—‘ N —

Clear Action Validation

If a variable is not selected from the drop-down list, an error marker is displayed on the figure to
indicate that a variable to clear has not been selected.

Connect Action

The Connect action is used to establish a relationship between records. It establishes a relationship
between the record being processed and accessed records

To define a Connect action, select the o=a Connect Connect action icon from the palette and drop it in the
appropriate (Else or Then) Action container.

Connect Action Properties

The following properties can be provided for the Connect Action in the Properties window, General
tab:
¢ Name: Any logical name for the Connect Action.

* Relationship: Select a Relationship name using which a relationship will be established.
Relationships for the associated repository are displayed here.

¢ Link Record -Type Variable: Select from the list of Declared link variables (with Link type as
Record) that are displayed here.

* Attributes: Click the appropriate icons to add or delete relationship attributes and provide values.
Multiple relationship attributes can be passed to the Connect action.

] Properties &3 [3_ Problems} 6_-| Error Log}

o=a Cnn
E—
General Marne: I cnn
Relationship: ICustomerToAddress j
* Link Record- IvarlinkRecord j
Type Yariable:

Attributes: Attribute | value

Connect Action Validation

If the Relationship and Link Record-Type Variable are not specified, an error is displayed on the figure.
Disconnect Action

The Disconnect action is used to remove relationships between records.Any relationship attributes
defined with the relationship are also removed.

To define a Disconnect action, select the osapisconnect Disconnect action icon from the palette and drop it
in the appropriate (Else or Then) Action container.
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Disconnect Action Properties
The following properties can be provided for the Disconnect Action in the Properties window,

General tab:
e Name: Any logical name for the Disconnect action.
e Relationship: Select the relationship to be deleted.

e Link Record-Type Variable: Select from the list of Declared link variables (with Link type as
Record) that are displayed here.

E Properties &3 ["_ Problems} QI Error Log} ¥ =0
o#a Discon
R
General Marne: I Discon
* Relationship: ISeIect... j
* Link Record- ISeIect... j
Type Yariable:

Disconnect Action Validation

If the Relationship and Link Record-Type Variable are not specified, an error is displayed on the figure.

Include Action

The Include action allows embedding one rulebase file into another.

To define a Include action, select the G Indude Include action icon from the palette and drop it in the
appropriate (Else or Then) Action container.

Include Action Properties
The following properties can be provided for the Include Action in the Properties window, General

tab:
¢ Name: Any name for the Include action.
* Logical Name: Any logical name for the Include action.

* Rulebase: Browse and specify the Rulebase to embed.

E Properties ©2 ¥ =8

3% IncludeRulebase

General Mame: IncludeRulebase
Logical Mame: Example of Include Rulebase
# [ulebase: DemofRulebase Models{Common/embedz, rul

Include Action Validation

If the relative path name for the Rulebase is not specified, an error is displayed on the figure.
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Include Rulebase
A rulebase file can be included in another rulebase using include action.

Using the Browse button in the include action property section helps to include a rulebase file. The
include rulebase allows you:

e To include a rulebase file present only in a workspace.
e Toinclude a rulebase file in .rul format.
e To open up the included rulebase file in the rulebase editor which is available as a link.

To list the variables defined in the included rulebase file in the variable listing of current rulebase file in
the rulebase data view. In addition it is also available in the content assist of the expression editor.

Including a Rulebase in a Current Rulebase File
To include a rulebase in a current rulebase file perform the following steps:

Procedure

1. Create a rulebase file and declare the variables and constraints.

At New.rul 23
Repository : PERSON

[ peclare varishles [E] Declare Constraints

B new_variable_1 Bﬁ& con_IncludeRulebae

B new_variable_2

B new_variable_3

2. Add Include Action to the constraint.

TIBCO® MDM Studio Rulebase Designer User's Guide



83

Al hew rul AP *hiew rul#con_IncludeRulebase &3

@ Condition [ actiors
L,_ i ———n (= Actions &
Then | % IncludeRulebase © m——
o=a Connect

osa Disconnect
5 Include:
% Propagate-Irline

Else| & Propagate-
Rulehase

o Selert
[ actiors S

@ Softlink

(= Condtion Expr... <

> < Expression

U Group Expression

& AHD

@R

B3 NatExpression

[ NetGroupExpre

[ properties &3 H~=0

%% IncludeRulebase

General Name: [ inchdeRulebase 1L

Logica Name: | Example o Inclde Rulebase | @

-

Click Browse in Include action properties section. The pop up window

M Tree Selection

Select the elements from the tree:

=2 Demo A~
(= Data Files
(= Exports
== Rulebase Madels
=-E3 Common
‘ita catalogyvalidation, rul
‘ita connectsample. rul

‘ita disconnectsample, rul

‘ita embed?.rul
&

‘ita embed3.rul

‘ita newrecord.rul

‘ita newrecord_embed,rul
‘ita queryanothercatalog, rul

2 Demot s

QK

':':’:' [ K H Cancel ]

The pop up tree selection window is displayed. Navigate to the common folder and select the
rulebase which you want to include and click OK.
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A #ew.rul Al *New rul#con_IncludeRulebase 5
.2 Palette

@ Condition [ actiors haao-

i (= Actions @

Then | 8 IncludeRulsbase -
o=a Connect
1 sa Disconnect
B9 Include
% Propagate-Inline

e Propagate-
Rulehase

o Select
[ actiors lEE
@ Softlink.

(Condition Expr... <

Else

>< Expression
Ui Group Expression
G AND

& oR

B3 NotExpression

[ NokGroupExpre.

[ Propertiss £3 ¥ =8
3% IncludeRulebase

General Name: IncludeRulebase

Logical Name: | Example of Include Rulebase

+ Rulsbasa! Dermo Rulebiass Madels{ Cormon/embed? rul

Click the newly added rulebase link. The included rulebase will open in the rulebase editor.

s hewrl &l Mew rul#con_IncudeRuebase S embedz.rul &3 =0
Repository : PERSON B 5 rane .
[E] Declare variables [E] Declare Constraints (= Dedare variables <0
B yar11 ol Short desc B Detartype
g Link-type
R variz (= Dedlare Constr... 4
&l Constraint:
BRvar1a (= Declare Decisi,..
BB, DeciionTable
>
[ Properties 12 ¥ =0
= SHORTDESC check
General * Name: SHORTDESC check.
Advanced
Description: Catalog Yalidations embedz
>

Rulebase Type |Yalidation

The new variables defined in the included rulebase appears in the variable listing of current
rulebases in the rulebase data view and also in the content assist of expression editor.
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[ *praject Explorer 57 = O s #mewul ol *New.rubkeon_IncludeRulebase 51 5 embedz.rul =8
== & 2 Palette b
= 14 pemo #||| @A Condition [ actiors R~

=15 Rulebase Models — 1 1 = actions @
(= Classification * ><Expresson ® Then =
= 1 o 1 % IncludeRuishase
= fial Commen @ Clear
- catalogvaldation.rul

) a-a Connect
13 comnectsample.rul

& A disconnectsample. rul oga Disconnect
® ":_.5- embedt.ul B Inchde

-5 embedz rul

Propagate-Tnline
513 embedz.rul Bse) adiiel
= e Propagate-
& 515 newrecord_embed.rul
= - Rulebase
A3 newrecord.rul
& 5 queryanothercatalog.rul & actiors o Select
74 adsn e
&) MassUpdate .
] search (= Condition Expr... <
=l el >< Expression
=z ke WA Group Expression
@ [E Daclars Constraints
) [5] Declare Variables @ AND
- Business Objects & OR
= v BT HotExpression
< 2 (3 NetGroupExpre
[ Deployment serv | B2} Rulebase Datavi 32~ — 0| — —
- properties £ (=]
$E S D B
¥ E: i
type filer text *pression
= ~
=[] woRKITEM Al|| General * Expression: val
3 E
Q =
A 5 ;:Q‘TC:JH‘STORV 7 validats_checksigit(checkdigiTyps, inputtalue)
b 9 Variable
® er
Revartl
= Wy User Defined E:
Hevarz
B new_varable_2 =
a3
B} new_varisble_t
- new_vanizble 3
B vart1
Y varlz
B} varts
= Templates v hd

Propagate Inline Action

The Propagate-Inline action propagates values from parent records to child records. It uses the Assign
Action to assign the attribute of the related record.

To define a Propagate-Inline action, select the

2 Propagate-Inline

Propagate-Inline action icon from the palette and drop it in the appropriate (Else or Then) Action
container.

Propagate-Inline Action Properties
The following properties can be provided for the Propagate-Inline Action in the Properties window,

General tab:
e Name: Any logical name for the Propagate action.

¢ Link Relationship-Record Type Variable: Select the variable to propagate a value for. This drop-
down lists all Declared link variables with Link type as Relationship-Record.

E Properties 2 ["_ Problems} QI Error Log} ¥ =0
& Propagate Inline-Type Action PrpCustToAdd
R
General Mame: I PrpCustToddd
* Link varlinkRelRecordCust ToAdd j
Relationship-
Record Type
Variable:

Click the Assign action within the Propagate-Inline action box in the Actions compartment to view the
Properties for the contained Assign action.

|
E':> Actiors

o PrpCust ToAdd

<= AsgAddress
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In the Assign action Properties, select the attribute of the related record from the drop-down and enter
the expression to access the parent record values. For example: select <AttributeName> in the Assign
drop-down and provide link.<parentrecord> in the Expression Editor.

Propagate Rulebase

The Propagate-Rulebase action propagates values from parent records to child records.

Unlike the Propagate Inline Action, it does not use an inline Assign Action, but requires you to provide
the rulebase file in the Properties.

To define a Propagate-Rulebase action, select the

¢ Propagate-Rulebase

Propagate-Rulebase action icon from the palette and drop it in the appropriate (Else or Then) Action
container.

Propagate-Rulebase Action Properties
The following properties can be provided for the Propagate-Rulebase action in the Properties window,
General tab:

e Name: Any logical name for the Propagate Rulebase action.

e Variable: Select the variable to propagate a value for. This drop-down lists all Declared link
variables with Link type as Relationship-Record.

¢ Rulebase: Browse to select the Rulebase.

'_i g i ["_ Problems} _Q_IError Log} ¥ =0

& Propagate Rulebase-Type Action test
I

General

Mame: I test

* Yariable: I Select... j

* Rulebase: IRecordCustToAdd [link]

Propagate-Rulebase Validation
(Short Description to be added).

Values for the Variable and Rulebase are mandatory; an error marker will be displayed on the figure if
these values are not specified.

Select Action

The Select action allows you to create a drop down with a list of values (LOV)for any attribute in the
MDM record UL

The attribute can be specified using Use for Variables (see Constraints). To do this, select the Constraint

in the main Declare Constraints compartment and in the Properties, select the variable in the Use for
variables list.
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= Properties 2 H. Problems| €] Error Log Data Source Explorer | Bl Console g ¥ =0

« select using table datasource

General Name: select using table datasource * Mo value: Default -
Advanced

Show On Input: Show Header: ¥/

* Select Type: Table -

* Source Type: Datasource - * Linktype Ds1 - £
Variable Source:
Type: @ Literal Constant Distinct: ]
* Source Attributes
* Attributes: [ SelectAll  Attributes
v id
ext
test_str
test_int
test_boolean
Order By:
* Where

The list of values can be populated from static constants and dynamic source. Static constant values can
be specified using Select Type as Enum and dynamic values using Select Type as Table.

To define a Select action, select the

o Select

Select action icon from the palette and drop it in the appropriate (Else or Then) Action container.

Select Action Properties
The following properties can be provided for the Select action in the Properties window, General tab:

Name: Any logical name for the Select action.

No Value: This specifies where an empty value appears (in the list). The following options are
available:

—  Default: The empty value appears as the first value in the list.

— Option: The empty value appears at the bottom of the list.

— No: The empty value does not appear in the list.

Showoninput: Specify the columns to display in a multi column drop down list. Enter single or
comma separated values. For example, if shownoninput=1,3 then columns 1 and 3 will be displayed
in the drop down in the record UL

Show Header: By default, there is no header in the data ( header="no"). Select this checkbox to
display as the column header.

Select Type: Type can be Enum or Table. Each type has a different set of properties displayed in the
Property window.

Enum Type: The following properties are displayed for the Enum Type:
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= Properties 2 Ef._ Problems @Error Log Data Source Explorer El Console ) | =

« select using enum

General Name: select using enum * Mo value: Option -
Advanced
Show On Input: Show Header: L
* Select Type: Enum -
Column: 0 Use First Row [
As Header:
* Attributes: Literal E
23.89
40,00
48.59

Column: The number of columns is solely determined by the col attribute.

Use First Row As Header: If you have select Show Header checkbox, then select this check-box if
you want the first row of data to be displayed as the column header.

Attributes: Add the static constants values to the table using the Add button on the right of the
table. Use the delete button to delete values from the table.

Table Type: The following properties are displayed for the Table Type:

= Properties 2 Ef._ Problems | €] Error Log ¥ Data Source Explorer| Bl Console g | ¥ =0

« select using table datasource

General Name: select using table da * Mo value: Default -
Advanced
Show On Input: Show Header:
* Select Type: Table -
* Source Type: Datasource - * Linktype Ds1 - £

Variable Source:
Type: @ Literal (™) Constant Distinct:

* Source Attributes

* Attributes: [ Select All Attributes
id
] et
[} test_str
[} test_int
[} test_boolean

Order By:
* Where

¢ Source Type: Defines the source to retrieve data from. Can be either Datasource or SQL.
* Linktype Variable Source: Lists repositories and datasources based on the selected source type.
¢ Type: Type can be either Literal or Constant.

¢ Distinct: Select this checkbox to filter duplicates and display only distinct or unique values from
retrieved values. For example, if a column for "city" has a city repeated twice, the result set will
display the city only once.

o Attributes: Displays attributes associated with the defined source type variable.

¢ Order By: Allows sorting the result set based on columns specified. Multiple columns can be
specified (comma separated).
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The value for order must be specified in the following format. order="[-]<columnpostion1>[,
[-]J<columnposition2>,..]"

where:
- indicates descending order
<columnpositon> specifies column position based on selected columns.

¢ Where: Type in an SQL where clause syntax.

Slice Action
The Slice action enables slicing a table into columns. Each column is assigned to a different variable.
These variables are usually passed into the rulebase for further processing.

To define a Slice action, select the

fff Slice

Slice action icon from the palette and drop it in the appropriate (Else or Then) Action container.

Slice Action Properties
(Short Description to be added).

The following properties can be provided for the Slice Action in the Properties window, General tab:

[ Properties 52 . 5 Problems| @] Eror Log | W Data Source Explorer | Bl Console e
§4H Slice
-
General Name: Slice L}
* Linl e Select... =
* Source Type: sQL s Var'fatifa Source:
Data Array Type | |iteral Attribute .-
Variable And %
Attributes:
QOrder By: Distinct:
~ Where
Where: 2 E]
Bind Attributes | parameter Type Value |

e Name: Any logical name for the Slice action.
e Source Type: Defines the source to retrieve data from. Can be either Datasource or SQL.
e Linktype Variable Source : Lists repositories and datasources based on the selected source type.

« Data Array Type Variable and Attributes: You can select one of these variables to hold the result of
the Slice action. If the rulebase has array type output or local variables then the rows of the table are
enabled.

—  Click on any row in the Literal column. The drop-down list displays all the available array type
variables. Select the appropriate variable.
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Click on the row corresponding to the selected literal in the Attribute column. The drop-down
list displays all the attributes of the selected Linktype variable source. Select the attribute which
you want to assign to selected variable.

You can select the variable only once. The selected variable is not displayed in drop-down list of
other literals.

To delete a row, double click on that particular row and click{x |

e Order By: Allows sorting the result set based on columns specified.

e Distinct: Filter and display only distinct retrieved values.

e  Where: Enter SQL where clause syntax.

e Bind Attributes: Enter the value for the statement parameter.

Softlink Action

The Softlink action allows establishing a link between records without permanent binding.

This is needed when records stored in different repositories need to be linked. For example, it may be
required to link records for vendors stored in one repository with customers in another repository.
Links will be evaluated on access, and evaluation could have different results depending on any data
changes.

To define a Softlink action, select the

{9 Softlink

Softlink action icon from the palette and drop it in the appropriate (Else or Then) Action container.

Softlink Action Properties
The following properties can be provided for the Softlink Action in the Properties window, General

tab:
] Properties &3 ["_ Problems} QI Error Log} ~
@ sflaction
[—
General Mame: I Lflackion
+ Mode: IRecord j
Where: varlinkCatalogCustormer PRODUCTID = "s¥Z' ;I = |

e Name: Any logical name for the Softlink action.

e Mode: The Softlink action supports two modes:

View (display mode) - Creates a hyperlink which executes a query when clicked, and returns a
list of records matching the selection criteria.

Record (non-display mode) - Executes a query and returns a list of records matching the
selection criteria. Additionally, populates a record link variable and the Usefor variable points
to the record link variable.

¢ Where: Allows to type in SQL where clause syntax. Specify in case of Slice use the Catalog link type
variable in the expression editor e.g. for Declared varCustomerRepo use
varCustomerRepo.PRODUCTID='11" and varCustomerRepo.PRODUCTIDEXT='11" in the
expression editor
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UnCategorize Action
This action allows to uncategorize the record from all the categories or selected categories.

Based on the mode the record is uncategorized. If the mode is set to 'ALL' the record is uncategorized
from all the categorizes. Similarly if the mode is set to "SELECTED" the record is uncategorized from
the provided categories.

To define an UnCategorize action, select the
EER UnCategorize

UnCategorize action icon from the palette and drop it in the appropriate (Else or Then) Action
container.

UnCategorize Action Properties

The following properties can be provided for the UnCategorize Action in the Properties window,
General tab:

¢ Name: Any logical name for the UnCategorize action.
¢ Explanation:A detailed description of the UnCategorize action.

* Mode:If the mode is set to 'ALL' the record is uncategorized from all the categorizes. Similarly if the
mode is set to "SELECTED" the record is uncategorized from the provided categories.

* Expression:Input parameters must be an array of link types classification code or any expression
that evaluates to classification code.
For example, the input parameters for categorize action:
getClassificationCodeByCode(CODEVAR_SOCIAL, 'P07') - This is a classification function that
returns classification code.
CODEVAR_DESKTQORP - This is link type classification code.
CODEVAR_DB - This is link type classification code.

= Properties #2  [2( Problems | ‘€] Errar LDQ ¥ =0

£ Un Categorize Action

A
General Mamne:
Explanation:
Maode SELECTED v
* Expression: E
v

UnCategorize Action Validation
(Short Description to be added).

By default, the Mode is ALL, if the mode is SELECTED, and Expression is not specified, an error
marker is shown on the figure.
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Severity Priority Refresh and Level

(Short Description to be added).

Severity

Priority

Refresh

Level

Validation can have a severity level associated with it. Severity levels can range from 1 (most critical) to
99 (least critical).

The lower the severity, the more serious the error. For example, a severity level of 2 is more serious
than a severity of 4.

Severity is specified as a Severity option (applicable for the Check and Select actions, displayed in the
Properties window, Advanced tab). You can specify the level of severity that must be reached for an
operation to fail. For example, if you specify the error severity as 4, all validations with severities less
than or equal to 4 cause the operation to fail. All other errors appear as warning or information
messages.

Validation can have a priority level associated with it. Priority values can be between -9 and 9. If no
value is specified, the priority is 1.

The value assigned to a variable is that of the highest priority assignment. Priority is specified as a
Priority option (applicable for the ___and actions, displayed in the Properties window, Advanced
tab).

When the user enters a new value in a drop-down list or in a text field, all attributes that use that value
in their computation are refreshed.

This refresh involves a trip to the server.

Sometimes, however, the benefit of having an updated value does not compensate for the delay
incurred in having to wait for that value. If that is the case, the system allows you to set the “refresh”
flag to “no”. This means that the dependent attribute value is not refreshed. By default the "refresh" flag
is set to "yes".

The refresh flag can be added to the following actions:

* <assign>
e <select>

o <clear>

Level is used to control the display of information messages in the Ul

All assignment messages with level less than or equal to information_threshold are displayed on the
UL The default value for level is 1.
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Rulebase Data View

The Rulebase Data View contains elements that can be used when building rulebases.
It contains artifacts imported through metadata import (such as users, roles, and repositories),
functions, variables and templates.
Rulebase Data View
The Rulebase Data View is usually present in the bottom left of the screen.

If not visible, you can add this view by going to Window > Show View > Other and then selecting
Rulebase Data View under Rulebase.

9 showvien ————RTeTFY

|type filker bext

B JavaServer Faces ;I
B2 P

B openarchitecturevare

(= PDE

(2 PDE Rurtime

B Report and Chart Design

B Repart Design

E| (= Rulebase

B Eo) Rulebase Data View

EB Server LI

Use F2 ko display the description For a selected
Wigw,

874 I Cancel |

Navigating through the Rulebase Data View
Icons are present at the top of the view to help navigate and filter components.

Click the Refresh button to refresh the view, Expand All to expand all components, Collapse All to
minimize components, and choose the project whose details you want to display in the current view.

Components

The following are available here:

Rulebase Data View components

Components Details

Domain Objects DataSources For details, see Domain
Objects.
Repositories
Roles
Users
Operators Math Operators For details, see Operators.
Comparison Operators
Functions Comparison For details, see Functions.
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Components Details

Math
String
Other
Variables Session For details, see Implicit
Context Variables.
Workitem

Synch_History

System

Other

Workflow

AttrivuteHistory

AttributeQuality

PrecedenceResult

User Defined

Templates For details, see Templates.

Domain Objects
This section contains Datasources, Repositories, Roles, and Users imported into MDM Studio.
See Importing Users and Roles, and Defining or Importing Repository Data.

Any of these components can be expanded; for example expand Repositories to see individual
repositories, attribute groups, attributes, and relationships.

=

[} Rulebase Data ¥iew 23
$ EH = O

|type filker bext

= (= Rulebase Domain Objects

E-{Z Domain Cbjects

B DataSources

EIE Repostories

B8 cusTomer

E| ttributes Group
| EME) UNASSIGNED

@ FIRSTHAME
@ LASTNAME
@ NAME

@ PRODUCTID

@ PRODUCTIDEXT
- [T SYSTEM

E---Eu Relationships

EI:qq'-'u CustomerTodddress [ADDRESS]
@ RESIDEMCE

@ SHIPPING
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Attributes and relationships can be directly dragged from the Rulebase Data View and dropped into
expressions for ease of use.

& ‘ Data Source in the same project are automatically updated into the Rulebase Data View.

Operators
This section contains Math and Relational Operators that can be used in expressions.

To add a math or relational operator, expand Operators, select the required icon under Math or
Relational and drag it into an expression.

Math Operators
(Short Description to be added).

e Minus
Y

e Div
%

e Mult
TN

e Percent
[ ] . +

e DPlus

Rulebase Data View X

wH =B B

bype filker bext

=l (= Rulebase Domain Objects -
B Domain Objects
E‘B Cperatars
2 math

Minus

(Short Description to be added).

Description Operands Returns Example
Calculates subtraction  1..n numeric Calculated numerical. Argl - Arg2 - Arg3 - ...
of values. expressions. Argn
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Div
(Short Description to be added).
Description Operands Returns Example
Calculates division of 1...n numeric Calculated numerical. Argl [ Arg2 [ Arg3/ ...
values. Xpressions. Division by 0 returns null. Argn
By default, results are
rounded to 8 decimal
places.
Mult
(Short Description to be added).
Description Operands Returns Example
Multiplies values. 1...n numeric Calculated numerical Argl * Arg2 * Arg3
expressions. * ... Argn
Percent
(Short Description to be added).
Description Operands Returns Example
Computes percentage.  1..nnumeric Calculated numerical. {(Arg2 - Argl)/
expressions. Argl}* 100
Plus

(Short Description to be added).

Description

Operands

Calculates addition of
values

1..n numeric
expressions.

Returns Example
Calculated numerical. Argl + Arg2 + Arg3
+... Argn

Relational Operators

(Short Description to be added).

* Not Equal to

* Scalar Matching - Not equal to

<
e Less Than

L
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e Less than equal to

e Equalto
=
e Scalar Matching - Equal to

>
e Greater Than

2=
¢ Greater Than Equal To

[} Rulebase Data ¥iew 23 i
RSB &S

|type filker bext |

EIB COperators
=32 Math

|>

=-#= Relational

Not Equal to
(Short Description to be added).

Description

Checks if first operand is
not equal to the second.

Operands

2 expressions.

Returns

true — if first operand is
not equal to second
operand.

false — if first operand is
equal to second operand.
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Example

Argl != Arg?2

Scalar Matching - Not equal to
(Short Description to be added).

Description

Operands

Returns

Example

To be used in conjunction
with NEQ (See Not Equal
to) for scalar
matching=false.

2 expressions.

true — if expression Argl
does not match the
Regular Expression Arg2.

false — if expression
Argl matches the Regular
Expression Arg2..

Argl I=~ Arg2
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Less Than
(Short Description to be added).

Description Operands Returns
Checks if first operand is 2 expressions. true — if first operand is< Argl < Arg2
lesser than the second. second operand.

false — if first operand is
>second operand.

Less than equal to
(Short Description to be added).

Description Operands Returns Example
Checks if first operand is 2 expressions. true — if first operand is Argl <= Arg2
less than or equal to the <=second operand.

second.

false — if first operand is
> second operand.

Equal to
(Short Description to be added).

Description Operands REI S Example
Checks if first operand is 2 expressions. true — if first operandis =~ Argl = Arg2
equal to the second. equal to second operand.

false — if first operand is
not equal to second
operand

Scalar Matching - Equal to
(Short Description to be added).

Description Operands Returns Example

To be used in conjunction 2 expressions. true — if expression Argl  Argl !=~ Arg2
with EQ (See Equal to) for matches the given regular

scalar matching=false. expression Arg?2.

false — if expression
Argl does not matche the
given regular expression
Arg2.
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Greater Than
(Short Description to be added).

Description Operands Returns
Checks if first operand is 2 expressions. true — if first operand is > Argl > Arg2
greater than the second. second operand.

false — if first operand is
< second operand.

Greater Than Equal To
(Short Description to be added).

Description Operands Returns Example
Checks if first operand is 2 expressions. true — if first operand is Argl >= Arg2
greater than or equal to the >= second operand.

second.

false — if first operand is
< second operand.

Functions
This section contains Comparison, Math, String, and Other functions that can be directly dragged and
dropped while building expressions.
¢ Comparison Functions
¢ Math Functions
e String Functions
¢ Other Functions

¢ (lassification Function

& Custom functions can also be created and saved as templates. For more information on creating custom
functions, refer Custom Functions.

Functions
Comparison Math String
Function Functions Functions Other Functions
changed round concat checkdigit validate_checkdig
it
defined length count toMultivalue
match Ipad distinct nvl
undefined rpad duplicate sequence
substring enum strip
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Comparison Math String
Function Functions Functions Other Functions
trim filter synchstatus
uppercase invokeJavaAPI syncOperationAtt
ribute
max tableDatasource
min tableSql
Comparison Functions
(Short Description to be added).
changed
(Short Description to be added).
Description Syntax Parameters Returns Example
If Variable is changed(variable, variable: true — if changed (SHORTDE
specified then keyword) Variable attribute value SC, ’PREVIOUS_V
attribute compare (optional) has changed ERSION’)
will be done and if from its
the Variable is not keyword previous
specified then (optional): version.
record compare PREVIOUS_VE false — if record
will be done. RSION
value has
(default), changed from
PREVIOUS_ C a8
ONFIRMED V its previous
ERSION) - version.
(Any one from
the parameter
list is
mandatory.)

defined
(Short Description to be added).

Parameters Returns Example

Description

Determines if value  defined(variable)

has been defined.

variable: true — if <var> defined(SIZE_UO
Variable(1 ton) has a non-null, M)
non-empty defined(SIZE U0
value.
M, PRICE)
false — if
otherwise
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in
(Short Description to be added).
Description Parameters Returns
Checks if operand  in(variable, array)  variable: true — ifargl in  in(PRODUCTID,
is contained in a Variable (arg2, {'XYZ
list. arg3, ..., argn). %', 'CCCCC'})
array: List of false —
values. .
otherwise.
like
Description Syntax Parameters Returns Example
Used to search fora boolean variable: The boolean like (PRODUCTID,
specified patternin  like(variable, Variable for value of the "XYZ%')
a variable. constantString) . pattern.
which pattern
has to be
searched.
constantString;:
Pattern string.
(Short Description to be added).
& ‘ The Like operator does not support attributes. It can only be used in sql expression.
match

(Short Description to be added).

Description Parameters

Returns

Example

Regular expression ~ match(variable, variable:
match. regexStr) Variable to
match

regexStr:
Regular
Expression

true — if first
operand
matches second
operand.

false — if first
operand does
not match
second operand.

match(GTIN, '/A\
\d{14}$/’)
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undefined
(Short Description to be added).

Description Parameters Returns
Determines if a Undefined(variab  variable: true — if the undefined (FIRST
value is undefined. le) Variable(1 ton) variable is null _NAME)

or empty.

false —

otherwise

Math Functions
(Short Description to be added).
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(Short Description to be added).

103

Parameters RES

Example

Description

Rounds to a round(num,
defined set of decimalPlaces,
decimal places. roundingMethod

)

num: Number or The array of round((11 / 9))
array of numbers. number .

equivalent to

. values.

decimalPlaces: round((11 / 9),
Number of decimal 0, 'HALF UP')
places to round to
(Optional). Default round((11 / 9),
to 0. 2)
roundingMethod: equivalent to
Rounding method round((11 / 9),
(Optional) 2, 'HALF_UP')
HALF_UP - default, round((11 / 9),
round up towards 2, 'CEILING')
"nearest neighbor".

round({(11 /
CEILING - round 9), 10.234,
towards positive 99.455}, 2
infinity. "CETLING')

DOWN - truncate
and round down
towards zero.

FLOOR - round
towards negative
infinity.
HALF_DOWN -
round down
towards "nearest
neighbor"

HALF_EVEN -
round towards even
"nearest neighbor"

UNNECESSARY -
assert an exact
result.

UP - increment and
round up to zero.

String Functions
(Short Description to be added).
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length

Ipad

(Short Description to be added).

Description

Concatenates string
values.

concat(strExpr)

Parameters

strExpr: string
expressions(1
ton)

Returns

String, which is
a concatenation
of all input

strings.

104

concat('PREFIX-
', "STRING', '~
SUFFIX')

concat('PREFIX-
', rpad (PRODUCT__
NUMBER, 9,

'A'),'-SUFFIX')

(Short Description to be added).

Description

Computes string
length.

length(strExpr)

Parameters

strExpr: string
expression

Returns

Length of the
specified string.

Example

length('PREFIX-
STRING-SUFFIX')

(Short Description to be added).

Description

Pads a string on the
left.

Syntax

Ipad(strToPad,
paddedStrLen,
charToPad)

Parameters

strToPad:
string or array
of strings.

paddedStrLen:

final length of

padded string.

charToPad:
character to
pad with
(Optional,
Default is
SPACE).

Returns

String.

Example

lpad('ABC’, 4)

lpad({'ABC',
'DEF'}, 4)
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(Short Description to be added).

Description

Parameters

Returns

105

Pads a string on the
right.

rpad(strToPad,
paddedStrlen,
charToPad)

strToPad:
string or array
of strings.

paddedStrLen:

final length of

padded string.

charToPad:
character to
pad with
(Optional,
Default is
SPACE).

String.

rpad('ABC’, 4)

rpad({'ABC',
'DEF'}, 4)

substring
(Short Description to be added).

Description Syntax

Substring of
current string.

substring(strT
osubset,
start,
numChars)

Parameters

strTosubset:
string.

start: start
position.

numChars:
number of
characters
(Optional,
default is
remaining
length).

Returns

Returns string
as the result of
substring
operation.

Example

substring('ABC'
, 1)

trim
(Short Description to be added).

Description

Parameters

Returns

Example

Trims leading and ~ trim(strExpr)

trailing spaces.

strExpr: string
expression.

String with
leading and
trailing spaces
removed.

trim(CUSTOMER_N
AME)
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(Short Description to be added).

Parameters

106

Returns

Description
Uppercase of input  uppercase(strE
string. XpT)

strExpr: string
expression.

String with all uppercase( 'aBcD
characters eF')

converted to

uppercase.

Other Functions
(Short Description to be added).

checkdigit
(Short Description to be added).

Parameters

Returns

Example

Description

Checks the number checkdigit(che
of digits in an ckdigitType,
attribute. inputValue)

checkdigitType
: Number of
digits to be
checked in the
input value.

inputValue:
string input
value.

String. checkdigit('14"'

, GTIN)

count
(Short Description to be added).
Description Parameters Returns Example
Counts number of count(val) val: Value or Number. count (CHILDCITI
(non-null, non- array of values. ES)
false) entries in ) )
array. count ({'PREFIX
, NULL,
"ABCD’ })
distinct

(Short Description to be added).

Description

Parameters

Returns Example

Returns distinct distinct(value
values. s)

values: Array
of values

Distinct values. distinct (CHILDC

ITIES)

count(distinct(
SIBLING_REL.UOM
))
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duplicate
(Short Description to be added).

Description Parameters Returns
Checks for records  duplicate(valu  values: value true: otherwise. duplicate (RECOR
with duplicate r array of .
P es) © yo false: if D_TYPE)
values. values. .
duplicate. duplicate (NAMES
)

enum

(Short Description to be added).

Description Parameters Returns Example

Defines a list of enum(values, values: array of ~ Array of values.  enum({'FA<sep/

values. col, header) strings (1 to n). >Farenheit',
col: number of 'CE<sep/
columns >Celcius',
(optional). 'KA<sep/

>Kelvin'}, 2)

header:
specifies if first enum({’ TEMP_UNI
row of data is T', 'FA<sep/
description of >Farenheit',
columns 'CE<sep/
(optional) >Celcius’,
HEADER_YES, 'KA<sep/
HEADER_NO. >Kelvin'}, 2,

HEADER_YES)

enum({'FA<sep/
>Farenheit',
'CE<sep/
>Celcius',
'KA<sep/
>Kelvin'}, 2,
HEADER_NO)
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(Short Description to be added).

Description

Filters a list of
records.

filter(records

selectionCrite

ria)

Parameters Returns
records: array Array of records
of records. that match filter
selectionCriteri criteria.

a: WHERE

Clause.

108

filter (CHILD_RE
CORDS, where
[PERISHABLE =
'YES' and DD =
'X'D

<op
func="filter">

<var>CHILD_RECORD
var>

<condition>
<and>

<eqg>

<var>EFFECTIVE_DA
var>

<var>RO0T/
EFFECTIVE_DATE</
var>

</eq>
</and>
</condition>

</op>

| LIST<,

TE</
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Description

Filters relationship
attributes.

Syntax

filter_relatio
nshiprecords(r
elationships,

selectionCrite

ria)

Parameters

relationship:
array of
relationships.

selectionCriteri
a: WHERE
Clause.

Returns

Array of
relationship that
match filter
criteria.
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Example

filter_relation
shiprecord(ccr_
relationship,
where

( AddressType =
'Y' D))

<op
func="filter_re
lationshiprecor
a">

<var>ccr_relationship</

var>
<condition>
<eg>
<var>AddressType</
var> <const
type="string">Y<
const>

</eqg> </
condition>
</op>

invokeJavaAPI

(Short Description to be added).

Description

Parameters

Returns

Example

methods.

Invoke in-built java

invokeJavaAPI(co
nstantString ,vari

able)

constantString:
Java function to
be called.

variable:
Parameter to
Java Function.

Result of
function on
variable.

invokeJavaAPI('
java.lang.Strin
g.length',
Variable)

lookup

(Short Description to be added).

Description

Parameters

Returns

Example

database.

Lookup value in

lookup( exprTo
Lookup,
tableExpr)

exprToLookup:
Expression to
lookup.

tableExpr:
Table
Expression

A string value
as a result of
lookup
operation.

lookup (UOM,
tableDatasourc
e('UOMCODES ',
'VALUE',
'"CODE'))

TIBCO® MDM Studio Rulebase Designer User's Guide



110

max
(Short Description to be added).
Description Parameters Returns
Maximum value. max(values) values: value Maximum value max(CHILDPRICES
or array of encountered. )
values(l to n). Nulls are
ignored.
min
(Short Description to be added).
Description Parameters Returns
Minimum value. min(values) values: value Minimum value  min(CHILDPRICES
or array of encountered. )
values(1 to n). Nulls are
ignored.
toMultivalue
(Short Description to be added).
Description Parameters Returns Example
Allows assignment  toMultivalue({  variable:array  Array of values. toMultivalue({'
for multi value variable}) of values. ', '2'H
variables (used
only for multi
value attributes).
nvl

(Short Description to be added).

Description

Substitues values
when NULL values
encountered.

nvl (exprl,
expr2)

Parameters

exprl:
expression 1.
expr2:
expression 2.

Returns Example

If expressionlis  nvl(expressionl
null, returns , expression2)
expression2;

otherwise nvl (expressionl
returns ’

expressionl. ‘expression2’)
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(Short Description to be added).

Description

Parameters Returns

111

Used to return the
next value from a
database sequence.

sequence (dbSeq
uenceName)

dbSequenceNa  Next sequence
me: name of value converted
the database to string.
sequence.

sequence ( 'MQ_SE
QUENCE_1")

sequence (mysequ
ence)

concat('HS="
lpad(sequence("’
MQ_SEQUENCE_1"')
, 9, '0"), '-
JAL"')

strip
(Short Description to be added).
Description Parameters Returns Example
Removes all null strip(Values) Values: array Array with all strip (CHILDWEIG
values from an of values. null values HT)
array. removed.
synchstatus
(Short Description to be added).
Description Syntax Parameters Returns Example
Gets record Synchstatus(ma marketplace: true - if record synchstatus('UC
synchronization rketplace, Marketplace/ has ever been Cnet')
status. operation) Datapool Added/ ,
Organization Published/ synchstatus('UC
name. Linked/ Cnet’,
. Committed to "PUBLISH')
operation: hi
Operation this
P Marketplace/
name Datapool
(Optional, pOOL
Default is false -
ADD. otherwise.
PUBLISH,
LINK,
COMMIT are

other options).
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(Short Description to be added).

Description

Parameters

Returns

112

Used to get the
operation date
(GDSN only).

SyncOperationA
ttribute(opera
tion,
datapool,
tradingPartner

D)

operation:
Operation
name (only
ADD
supported
currently).

datapool
(Optional).:
marketplace or
datapool name.

tradingPartner
(Optional):
trading partner
name.

Latest
synchronization
Date for the
operation.

SyncOperationAt
tribute('ADD',
Datapoolname,
TradingPartnerN
ame)

tableDatasource

(Short Description to be added).

Description

Syntax

Parameters

Returns

Example

Selects values from
a datasource.

tableDatasourc
e(datasourceNa
me, columns,
whereClause,
DISTINCT)

datasourceNa
me: name of
the datasource.

columns (1 to
n): array of
columns.

whereClause:
where clause
(optional).

DISTINCT
(Optional): The
valid values
are
DISTINCT_TR
UE and
DISTINCT_FA
LSE.

Array of values.

tableDatasourc
e (COUNTRYCODES,
COUNTRYCODE,
COUNTRYNAME ,
where like
(COUNTRYNAME,
"Arg%'))
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tableSql

(Short Description to be added).

Description

Parameters

Returns
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(Optional): The
valid values
are
DISTINCT_TR
UE and
DISTINCT_FA
LSE.

Selects values from  tableSql( vari  variable.colum  Array of tableSgl(var.co
a repository. able.column, n: array of records. untryname,
whereClause, columns from a where
DISTINCT) repository COUNTRYNAME
Variable. like(' Arg% D))
whereClause: Where var is a link
whe}'e clause type variable
(optional). pointing to the
DISTINCT repository.

toDate

(Short Description to be added).

Description

Parameters

Returns

Example

Converts string to toDate(datestr  datestr: Datein  String converted toDate(’12/10/2
date. ) string format. to date. 010’)
validate _checkdigit
(Short Description to be added).
Description Syntax Parameters Returns Example
Validates a set of validate_check  checkdigitType true - string gets validate_checkd
digits against a digit(checkdig :Standard to validated igit(GTIN-14,
format. itType, verify against.  against the GTIN)
inputvalue) inputValue: format.
String. false -
otherwise.

Classification Function

There are two types of custom functions for classification in the rulebase.

* Record based: The record parameter is implicit and mandatory for these custom functions. The

following are the record based custom functions:

isRecordCategorizedUnderScheme
isRecordCategorizedUnderCodesPath
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isRecordCategorizedUnderCodeNamesPath
isRecordCategorizedUnderMultipleCodePaths
isRecordCategorizedUnderMultipleCodeNamePaths
getClassificationCodePathsForRecord
getClassificationCodeNamePathsForRecord
getClassificationCodesForRecord
getClassificationCodeNamesForRecord
isRecordCategorized
isRecordCategorizedUnderAll

¢ Metadata based: The metadata parameter is not implicit parameter. The following are the metadata
based custom functions:

getClassificationScheme
getClassificationCodeByCode
getClassificationCodeByName
getClassificationCodeForCodesInPath
getClassificationCodeForCodeNamesInPath
getClassificationCodelevel
isSubCategoryOfCode

isSubCategoryOfCodeName
stringTreepathOfCodeToClassificationCode
stringTreepathOfCodeNamesToClassificationCode

For more information, refer getClassificationScheme.

Built-in Functions

The built-in function is called with the following syntax:
<op func="funcname"></op>

Child values are considered arguments to the function. In turn, each function returns a result value
which can be used by another function.

Custom Functions
In addition to the built-in functions, you can write your own functions.

During rulebase execution, if an unknown function is encountered, the application looks for the custom
function definition from RulebaseCustomFunction.class.

It is located in the following directory:

$MQ_COMMON_DIR/<internal_enterprise_name>/rulebase

Creating a Custom Function
(Short Description to be added).

Procedure

e Copy the sample RulebaseCustomFunction.java file from $MQ HOME/common/standard/rulebase.

This class has a predefined method, execCustomFunction, with the following signature.
public HashMap execCustomFunction(HashMap args)

This method takes one argument, which is a HashMap and expects HashMap in return. The
following is a list of predefined constants that can be used:
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Input HashMap
The input HashMap has the following entries:

Equivalent String

Rulebase Constant Constant Description

FUNCTION_NAME FUNC_NAME The name of the function to execute.

FUNCTION_ARGUMENTS  FUNC_ARGUMENTS ArrayList of input arguments.

FUNCTION_ARGUMENTS are passed in an ArrayList with the same order as that specified in the
rulebase constraint. The following is a list of data types in the rulebase and corresponding Java types:

Rulebase Type Java Type

string String
number Long

BigDecimal
boolean Boolean
date java.util.Date
array java.util. ArrayList

Output HashMap
The output HashMap has the following entries:

Equivalent String

Rulebase Constant Constant Description

FUNCTION_SUCCESS FUNC_SUCCESS Set to Boolean.

TRUE, if function found and executed
successfully else Boolean.

FALSE.
FUNCTION_RETURN_VALUE FUNC_RETURN_VALUE Output of the function.
FUNCTION_ERROR_MESSAGE FUNC_ERROR_MESSAGE Error message in case error occurred in

function execution.

This error message is logged in the
$MQ_HOME/elink.log file.

Implement custom function as a separate method and call it from execCustomFunction depending
upon the FUNCTION_NAME passed in.

For example:
if (funcName.equals("checkNumber"))

{
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retValue = checkNumber(inArgs);
}

Compile the RulebaseCustomFunction.java. For example:

javac RulebaseCustomFunction.java -classpath $MQ_HOME/lib/mq/Al1ECMClasses.jar:
$MQ_HOME/lib/external/log4j-1.2.14.jar

% Ensure that $MQ_HOME/1ib/mqg/Al11ECMClasses.jar and $MQ HOME/lib/external/log4j-x.x.jar
are in the classpath for compilation.

Copy the RulebaseCustomFunction.class file to $MQ_COMMON_DIR/<internal_enterprise_name>/

rulebase folder and restart the application server.

Custom Rulebase Class Example
(Short Description to be added).

For an example, refer to $MQ_HOME/common/standard/rulebase/RulebaseCustomFunction. java.

Variables

For details, see Implicit Context Variables.

Templates
The Rulebase Designer provides some basic ready to use templates.

These are present under Templates in the Rulebase Data View. Drag and drop directly into
expressions.

[} Rulebase Data ¥iew 23 =0
$ EH = - O

|type filker bext

= (= Rulebase Domain Objects
B Domain Objects
(= Functions
(= Variables
B- Templates
5 countFunction
enurnlndssign
lookupFunc
matchFunc
rollup
selectwhereclause

Templates tableInAssign

Template Description Syntax

countFunction This template uses the count and  count( PERISHABLE_LIST :=
filter functions (count and filter). =~ filter( CHILD_RECORDS,
The result of filter is assigned toa ~ WheTe PERISHABLE = "YES'
temporary variable, i.e. and DD = X' )) > 1
PERISHABLE_LIST, that the
count function operates on.

lookupFuncUsingEnum This template uses the enum and ~ lookup(TEMPCODE,
lookup functions (enum and enum({'FA<sep /
lookup) to look for TEMPCODE >Fahrenheit', 'CE<sep /
in the enum list. >Celsius'},2))
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lookupFuncUsingTableDa
tasource

Description

This template uses the lookup
and tableDatasource functions
(See lookup and tableDatasource)
to look for a specified distinct
name from the datasource.
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Syntax

lookup (NAME,
tableDatasource('DS1',

{ PRODUCTID, PRODUCTIDEXT},
where (PRODUCTID = 'abc'
and PRODUCTIDEXT =

'abc ') ,DISTINCT_TRUE ))

lookupFuncUsingTableSql

This template uses the lookup
and tableSql functions (See
lookup and tableSql) to look for a
specified distinct name from a
repository.

lookup (NAME,

tableSql({ varl.PRODUCTID,v
arl.PRODUCTIDEXT},
(PRODUCTID = 'abc'
PRODUCTIDEXT =
'abc') ,DISTINCT_TRUE ))

where

and

matchFunc This template matches variables match(useforvars, '/AC(\\d+
defined in useforvars with the ANANAF)?) | ANA*\\ . \\d+))
provided regular expression to $/")
find non-negative numbers.

rollup This template uses the nvl +(CONTAINSREL.QUANTITY *
function (See nvl) to get the value  nv1(CONTAINS_RECORD.NETWEIG
of NETWEIGHT of the child HT,100))
record. The result of its product
(multiplied) with quantity is
rolled up.
CONTAINSREL and
CONTAINS_RECORD are
Linktype-Relationship type user
defined variables.

selectWhereClause This template is for use with the mcl.PRODUCTID = '1111' and
Select action. It shows the use of a  mc1.PRODUCTIDEXT = '33333'
simple expression in the where
clause.

tableInAssign This template uses the tableSql tableSql({COL1,COL2}, where
function (See tableSql) . coll and COL1='ddddddd' and
col2 specify the columns that the COL2="'sssssssss')
table function provides values for.
The second parameter provides
the selection criteria for records.

toDateWithIn This template uses the toDate in(DateOfBirth,

function (See toDate) to convert
given strings to date format and
then searches for DateOfBirth in
them.

{toDate('10/2/86"'),toDate(’
12/3/56')})
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Deployment

(Short Description to be added).
This chapter explains direct deployment of rulebases created in MDM Studio.

Deployment Overview

MDM Studio supports direct deployment of defined rulebases to MDM.

This direct deployment of rulebases created in MDM Studio provides a quick way to deploy the
graphically defined components - rather than the conventional and slower method of using the export
wizard and importing/moving the exported file to the MDM server manually.

Network deployment is a web service, through which you can deploy and undeploy rulebases.
Internally, MDM Studio stores rulebases in XML Metadata Interchange format (XMI). Before
transporting to the MDM server, this is validated, translated into native MDM format, and then
executed.

Before you attempt direct deployment, first establish a connection to a MDM Server.

Creating a MDM Deployment Server

&

(Short Description to be added).

MDM network deployment service requires administrative privileges.

In case you do not see the Deployment Server Pane, go to Window > Show view > Other and select
Deployment Server under Studio. Click OK.

Procedure

1. Select File > New > Other.

”Rulehase - RulebaseTest/Repository Models/RepositoryModel.rep - TIBCO Business
File Edit Diagram Mavigate Search Project Run  Window Help

LSSV ) Project...

Open File. ..
[ Example. ..
Close Chrl4+-i
Close Al Chrltshiftew R Ctrh+N I
|| save Crl+s DataDomain Diagram I

2. Select Business Modeling > Deployment > Server .
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e o
Select a wizard

Create a new Deployment Server configuration.

Wizards:
| type filter text

% Analysis Project
%) BPM Developer Project
[F¥ Business Object Project
[ MDM Developer Project
% Organization Project
2 Quality Process Project
[ 2= Business Object Modeler
[ [= Business Process Modelling
> [ Classification Scheme
[» [ Datasource Model
4 = Deployment
|EE Server |

Server Name and Runtime
Select type of the server,

Server Parameters:

Name: 10.97.97.241

Buntime: | MDM Server

4. Enter the BaseURL, Enterprise, User Name, Password and select Remote as the Repository Type. If
you select the Save password option, you will not be prompted for a password in the following
step. Click TestConnection. You will received successful connection message. Click Finish.
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0% Outline ﬁw & ¥ =0
4 [[9 Deployment Servers
}E 109710861
|[ 10.97.97+
MNew
Refresh F5
Deploy Module ...
Connect
Disconnect
¥ Delete Delete
Properties Alt+Enter
x
Enter passward: |
[8]4 I Cancel
Result

Server

Set parameters of the runtime server.

vy New Server 5 | ——
W -
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Runtime Server Parameters:

Base URL  http://10.97.97.241:8080

Enterprise  enterprisel

User Mame  john

Password ¥+

@ Saved passwords are stored on your computer in a file that is difficult, but not

impossible, for an intruder to read.

Repository:

Test Connection

Repository Type: | Remote

1)

In the Deployment Server pane, right click the created MDM Server and click Connect.

If you did not choose to save the password, you will be prompted to enter the password.

This establishes a connection between the MDM Server and MDM Studio client and shows all deployed
modules on the MDM server.
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[9 peployment Server &2 = <f;> e

=] E;:i Deployment Servers i

== test
= Process Models
== Repository Models
== demarepository
== ACCOUNT
= ADDRESS
== ASSET
== BAMK
== CUSTOMER
== Rulebase Models
E. demoallactions
== EMAIL
= ORGAMIZATION
== PERSOMN
== PHOME
(= RECRUITERS 3
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Deploying TIBCO MDM Studio where SSL is Enabled
To deploy TIBCO MDM Studio where SSL is enabled follow the steps:

Procedure

1. Copy keystore file on the same machine where TIBCO MDM Studio is installed.

2. Copy -Djavax.net.ssl.trustStore parameter in the studio.ini file. The studio.ini file is located in
$TIBCO_HOME/studio-mdm/4.1/eclipse/TIBCOBusinessStudio.ini.

3. Specify the keystore file path in the newly added parameter. For example, -

Djavax.net.ssl.trustStore=C:/app/foo.keystore

Result

& ‘ If you want to use SSL enabled URL, enter the URL in Base URL field as "https://<hostname>:<port>".

Direct Deploying of Rulebases

The following are the steps involved in directly deploying rulebases:

Procedure

1. In the Deployment pane, right click the <MDM Server and select Deploy Module.

2. Select the modules to deploy. Click Next.
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 Deploy MDM Design Artifact(s)

Select Modules

Select modules you want bo deploy.

Supporked Modules:

122

Prioject

[ pema
= [ pemot

o (s F 3
[[] & repasitory Madels
= [#] (= Rulebase Madels
[¥]E3 Common
t:ﬁ Gdsn
I:_'@ MassUpdate
V][5 search
[[] = Datasources
[[] = Sync Formats

Dg Demo3

|

IE3

Mext = ] I

Finish H Cancel ]

Select the rulebase (.rul) file to deploy. This is listed under the relevant repository model
(.rep file). Expand the .rep file and repositories under it to see associated .rul files.

3. Select the enterprise to deploy the rulebase to (either the current enterprise or standard). Click

Finish.

) Deploy MDM Design Artifact(s)

Enterprise Selection

Select enterprise in which you wank ta deplay modules,

Enterprise Selection
(#)techpubs
() standard

Walidating repository models. ..

4.

Result

ﬂ Deployment results

@ Deployment finished. Mo errors were reported,

" Dot show this again

(7)

(@) QK I Details == |

If deployment is successful, you will get a message confirming it. Errors, if any, will be displayed.

Once successfully deployed, you can log onto the MDM Server and check if your rulebases and

repositories have got included.
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Undeploying Rulebases

To undeploy a rulebase from the server:

Procedure

In the Deployment Server view, expand Deployment Server
Then expand <MDM Server><EnterpriseName><Rulebase Models>.rul file.

1

2

3. Right click the deployed .rul file and select Undeploy.

4. You will get a message to confirm undeployment. Click Yes to undeploy.

Result

[i} Rulebase Data View | {3 Deployment Server 53 =0
=
= <)==D

= EE Deployment Servers
EI'E CIM Server
E‘B Candice
B Process Models
- Repository Models
B2 RepositoryMadel
(= cal
EB Rulebase Models

..... = caz - Undeploy |

. = Rulebase Models

This undeploys the selected component, and a backup of it is internally renamed and stored.
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Import and Export Rulebases

(Short Description to be added).

This chapter explains importing MDM rulebases into MDM Studio and exporting rulebases created in
MDM Studio.

Importing Rulebases

Existing MDM rulebases can be imported into the Rulebase Designer. Follow these steps to import
rulebases:

Procedure

1. Select the project you want to import the rulebase into; right click the Rulebase Models folder in
that project and select Import.

2. Select Import Rulebase under MDM Rulebase Designer. Click Next.

~
Wy Import = ﬁ
Select \“
Import existing rulebase xml as a diagram into Rulebase Designer, E 5 ]

Select an import source:

type filter text

- [= General -
> [= Business Object Modeler
» [ Business Process Management
> = CVS
- [= Install
> [= MDM Data Source Designer
> [= MDM Process Designer
> [= MDM Repository Designer
4 [= MDM Rulebase Designer
3, Import MDM Users and Roles
3 Import Rulebase
> [= MDM Synchronization Format Designer
- [= Plug-in Development
> [= Run/Debug
. (= Servire Renictrs

= —
'.2,‘ < Back Mext = Finish Cancel

3. Browse to the location (folder) of the Rulebase (xml) and select the checkbox against the appropriate
file. You can also Browse to change the folder that the Rulebase should be imported into. Click
Next.
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 Import Rulebase

Import Rulebase
From Cirectory: | E:\Techpubsi3, 20054 vl [Bmwss..‘ ]
= can %] catalogvalidation, xml
|¥] rulebaseartifacts, xml
Select Al | | Unselect Al
Inka Folder: ‘ Proj/Rulebase Models | ‘ Browse... |
Options
D Overwrite existing resources withaut warning
®

4. The selected rulebase will be displayed along with its type. Select a .rep file (model) to associate
(from the Repository Model dropdown) and then click in the Repository column and select the

repository to associate or click in the Relationship column and select the relationship to associate.
Click Finish.

Result

RI=TE
Import Rulebase Parameters

Associake a repository model, You may associate repository andjor relationship For the
rulebase depending on the rulebase bype,

Repository Model |demorepository.rep j

Impork File Rulebase Type Repositor Relationship

SampleRulebase. xml Yalidation CUSTOMER

Mone

@) < Back | Mext = | Finish I Cancel |

The imported rulebase will then be displayed in the appropriate folder (the one selected for import
into.)

Exporting Rulebases

Follow this process to export rulebases designed into the Rulebase Designer into MDM.

Procedure

1. In the Project Explorer, right click the rulebase file (.rul) to export and select Export > Export .
2. Select MDM Rulebase Format under MDM Rulebase Designer and click Next.
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Select ﬁ
Export Rulebase

Select an export destination:

‘type filter text |

(= Em

= Java

= lava EE

(= Javascript

[= MDM Data Source

== MDM Process Designer

(= MDM Repositary Designer

(== MDM Rulebase Designer
I3110M Rulebase Format

(= MDM Synchronization Format

(= Plug-in Development

= Run/Debug

(= Team

[= Weh

(= Web Services

=

[N

|2

<

3. Select the rulebase file to export by selecting its checkbox. Accept the default destination (an
Exports folder under the project) or provide a path.

s MDM Rulebase Designer Export Wizard ‘ El £ ‘

MDM Rulebase Designer Export Wizard
Select Concepts for Export to MDM Rulebase Format

o [0 testl A
4 [W][E5 Rulebase Models
[71EZ Common
% default.rul
DE:;- Gdsn N
[/ & MassUpdate
[F] &= Other
[T E5) Search
1M UBuilderTutarial

Destination
@ Project (Location: /Exports)

m

© Path: Browse...

@ Next > [ Einish } [ Cancel
4. Click Finish.

TIBCO® MDM Studio Rulebase Designer User's Guide



127

Rulebase Examples

(Short Description to be added).
This section has extensive rulebase code examples divided into functional segments (modules) to call
attention to each of their functions.
Sample -1
(Short Description to be added).

The following is a sample rulebase of catalog validations for Person repository. The Rulebase type used
in this sample is of type validation.

Rulebase Sample
Repository : PERSON
[l Declare variables [E] Dedare Constraints
e CONTAIMNSOQUANTITY E@ Cnt_Assign Constant Action
Sy CONTAINEDQUANTITY E&‘P Cnt_Conditional Assign Action
=y CONTAINSMANAGER 5@5 Chnt_Access Action
o ADDRESSCATALOG & Cnt_Chieck action
f\ ADDRESSRECORDS & Cnt_Saftlink Action
SR UPSELL_RELATIONSHP Al cnt_Connect At
R RECORD_LIST &ffp Cnt_Disconnectaction Patl
e CONTAIMSLINE E@ Cnt_Disconnectaction Patz2

E&‘P Cht_Include Action

E@& Cht_Propagate rulebase and inline
fr Cnt_Select Action with erurm

fr Cnt_Select Action with table dat...
ot _sice Action

E@“ Cnt_Assign Array Action

Assign Action Constant

In this example, a constant value is assigned to a variable. Double click on the Cnt_Assign Constant
Action container, the rulebase opens in a new edjitor.

A constant value "31" is assigned to the variable "age".
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Assign Action with General Properties

Wy
F%E *catalogvalidation.rul F%E *takalogvalidation. rul#Cnt_Assign Constant Action &3
g
@ Condition & actiors N
* [ =
Then <= assign constant .
[F1
Else|
[ actiors G
==L
»
u
4
%
@

E Properties &2

4 assign constant

General Marme: assign conskank
Advanced

* Assign: age w| = Fi

Assign Action Rule Advanced Properties

= Properties 3 %
=» assign constant
General Level: 1 Priority: 1
Advanced
Refresh: Curnulative:

Assign Action Conditional

In this example a conditional value is assigned, if salary is other than 80000, then productidext is
Manager else assign session variable constant.

Double click the Cnt_Conditional Assign Action container, the rulebase opens in a new editor.
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Assign Action with Conditional General Properties

% *catalogvalidation.rul (% *catalogvalidation.rul#Cnt_Conditional Assign Action &3 =0
|57 Palette [+
@A Condition & Actions m @ e~
If -
> £ Expression) Th - B S7Acions “
e <z assign constant t... & Access
& Assign

[25] Assign Identity
ng Categorize

Else] E?; UnCategorize

(= Condition Exp... <

[& Actions »< Expression

- X X Ui Group
“z» assign session var Expression

— 4 AND
T| @ OR
1 * AW R1_arT. =
El Properties £ . [f1 Problemq @ Error Log} ?| &%~ -0
*< Expression
I
General * By P - o~
pression: lin[SALARY, {3 -
inf {80000}

Assign Action with Else condition General Properties

=l Properties 53

%> assign session variable constant to ext

E— I3
General Marne: | assign session variable constant to ext

Advanced

* Assign: | PRODUCTIDEXT w| = 'SESSION/USER_ROLES'

Assign Action
(Short Description to be added).

In this example, a Assign action with arrays is defined.
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Assign Action with array with General Properties

“-«‘6 *catalogvalidation.rul “-«‘6 *tatalogvalidation.rul#Cnt_Assign Atray Action &3
@4 Candition & actiors
w [
Then <= assign some list ...
Else|
E':> Actiors
E Properties &2
4 assign some list of costants to sliced array
General Mame: assign some list of costants ko sliced array
Advanced
* Assign: ARR_PROD_ID v =| {a,8,'Ch

Access Action
In this example a access action is defined.

If a person is a manager, modify access is provided for the contains count and view access is for

containby count.
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Access Action Modify with General Properties
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% *ratalogyalidation. rul (% *catalogvalidation.rul#Cnt_access Action &2

I

@ Condition

Elsef

|g=':> Actiors

If
> < Expression —,— Then

W

|g=':> Actiors

@ modify access to...

@ View accessto RA

=B . - v@)|r:.‘\n\ mEE BEE BT N A @)|§||g°g

E Properties &2

@ modify access to RA

I
General Mame: | modify access ko R
* Mode: |M0dify
* Applies to: | Relationship Attributes

* Link Relationship |CONTAINSQUANTIT\" [containsfcount]

Type Yariable:

Access Action View with General Properties
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% *ratalogyalidation. rul % *catalogvalidation.rul#Cnt_fccess Action &2

"

@4 Candition & actiors

Ean
»>< Expression Then @ modify access to...

@ View accessto RA

W | 27| s
B e .

Elsef

R T

=

|g=':> Actiors

e

s,

1= -

E Properties &2

@ Yiew access to RA %

General Marme: | View access ko RA

* Mode: | Wiew s

* Applies to: | Relationship Attributes s

* Link Relationship |CONTAINEDQUANTIT\" [containedby fcount] z
Type Yariable: '

Check Action

In this example, a check action is defined.

A check is done to check the CTC format and the starting substring.
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Check Action with General Properties

% *catalogvalidation.rul % *tatalogvalidation.rul#Cnt_Check Action 23
@4 Candition & actiors
. [
PAISEEER Then @ checkcte format ...

] Properties &3

Elsef

ES Actiors

) check ctc format and starting substring

General Mame:

Advanced

Explanation:

Information:

* Expression:

133

|z

W || ]| 52
oD =

BT g

oo mom
foe 600

U

[ B

Yheck che Format and starting substring

CTC cannot skart with 123, 234, 456, 000, 001,002, 003,004, 005, 06, 07

1 in{substring(cte, &, ), 123, 274, 455, 006, 001, 602, 007, 004, J95) or in{ subséringlcte, 0, 21, 08, ‘07

Check Action Rule Advanced Properties

= Properties 3

& check ctc format and starting substring

General Severity:

Advanced

Softlink Action

E | @

(Short Description to be added).

In this example, a softlink action is defined to return ADDRESS records having the CUSTOMERID

similar to the record being processed.
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F%E *catalogvalidation.rul F%E *¢ akalogvalidation. rul#Cnt_Softlink Action &3

@ Condition

E':> Actiors h
If -

Then @ link recard mode

Elsef

E':> Actiors

. ow.  DOD ©OE B

L 3 Q:

E Properties &2

@ link record mode

General

Mame: link. record mode
* Mode: Record
Where:

ADDRESSCATALOG.PRODUCTIDERT = PRODUCTIDEXT

Connect Action

In this example, a connect action is defined.

The address records are connected using the Person to Address relationship.
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Connect Action with General Properties

rsfa *catalogvalidation.rul E&% *takalogvalidation. rul#Cnt_Connect Ackion 23 L\§
@4 Candition & actiors
w [
Then o=a Connect Person t..,
Else|
E':> Actiors
E Properties &2
oo Connect Person to address
General Mame: Connect Person ko address
* Relationship: PersonToAddress
* Link Record- ADDRESSRECORDS  [link]
Type Yariable:
Attributes: Attribute Value
TYPE MAILIMG
permanentAdd yes

Disconnect Action
In this example, a disconnect action is defined.

A list of records is obtained to disconnect and is assigned to variable.
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Disconnect Action with assigned records with General Properties

“-«‘6 *catalogvalidation. rul “-«‘6 *¢atalogvalidation.rul#Cnt_Disconnectfction_Partl &3 E&_«‘a *catalogvalidation. rul#Cnt_DisconnectAction_Part2
@4 Candition & actiors
w [
Then = assign record list...
Else|

E':> Actiors

E Properties &2

4 assign record list to filtered records and put in record_list

General Mame: assign record list ta Filtered records and put in record_list
Advanced
* Assign: RECORD_LIST | = fifter{UPSELL_RELATIONSHIF, where SHORTDESC = 'test’)

Disconnect action using record list with General Properties
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“-«‘6 *catalogvalidation. rul “-«‘6 *catalogvalidation. rul#Cnt_Disconnectaction_Part1

@ Condition

If
> < Expression —,— Then

Elsef

E':> Actiors

E Properties &2

&4 disconnect using record_list

General Mame: disconnect using record_list

* Relationship: PersonToAddress

* Link Record- RECORD_LIST

Type Yariable:

Include Action
In this example, a include action is defined.

137

“-«‘6 *catalogvalidation.rul#Cnt_Disconnectfction_Partz &3

E':> Actiors

osa disconnect using ...

If last name is defined then include another rule to clear attributes else include hidden rule.
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Include Action rule to clear attributes

m_«‘a *catalogvalidation.rul E&_«‘a *akalogvalidation. rul#Cnt_Include Action &3
gl
@4 Candition & actiors Iy
If
) ;
»< Expression —,— — =
Then “Hhinclude anatherr... P
[
Else| i
p
b
E':> Actiors G
5% Include Hidden rui =
>
u
4
U
E Properties &2
B3 include another rule to clear attributes
General Mame: include another rule to clear attributes
Logical Mame: Logicalkamel
* plebase: standardfrulebase/ClearRule. rul Browse.,

Include Action hidden rule
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‘ﬁ% *catalogvalidation. rul Rz% *catalogvalidation.rul#Cnt_Include Ackion &3

@4 Candition & actiors [s

" =
#< Expression Then ¥ include anotherr...

Elsgf B
E':> Actiors c
1 Include Hidden rul= =
3
!
:
E
i
E Properties &2
B3 Include Hidden rule
General Mame: Include Hidden rule
Logical Mame: LogicalMamez
* plebase: standardfrulebase/hiddenRule. rul Browse.

Propagate rulebase and inline Action
(Short Description to be added).

In this example, a propagate action is defined.
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Propagate Action with General Properties

% catalogvalidation.rul
@4 Condition & Actions
L
Then g PropagateAction-...
Else
|g='¢ Actions
4 b
= Properties 2 B Problemq @] Error Log} = | &~ =0
o Propagate Rulebase-Type Action
I
General Name:
* Link | UPSELL_RELATIOMNSHIP = |
Relationship-
Record Type
Variable:
* Rulebase: /MDM Rulebase Model Sample/Rulebase Models/Common/ClearRule.rul

Select Action enum
(Short Description to be added).

In this example, a select action with enum is defined.
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Select Action with enum with General Properties

% catalogvalidation.rul (% catalogvalidation.rul#Cnt_Select Action with enum 232 =0
i
@4 Condition & Actions
L
Then
Else
|g=':> Actions | 4
4 k
= Properties 2 g,_g Problemq @] Error Log} ¥ Data Source Explorer} = Console} il | &~ =0
o select using enum
1 R
General Name: select using enum * Mo value: | Option - |
Advanced
Show On Input: Show Header:
* Select Type: Enum - |
Column: 0 Use First Row
As Header:
* Attributes: Literal
23.89
40,00
48.59 -
Select Action Rule Advanced Properties
= Properties 3 N

o select using enum

General Saverity: ||1 | Refresh: O

Advanced

Select Action Tables
(Short Description to be added).

In this example, a select action with table datasource and sql is defined.
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Select Action with table datasource table
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% catalogvalidation.rul (% catalogvalidation.rul#Cnt_Select Action with table datasource and sql 2 =08
Y
@4 Condition [& Actions
L
Then o select using table...
of select with table sgl 7
Else
|g='¢ Actions LM
4 3
= Properties &2 E.; Problemq @ Error Log} ¥ Data Source Explorer} = Console} g | &~ =0
o select using table datasource
I w
General Name: select using table datasource * Mo value: |Defau|t v|
Advanced
Show On Input: Show Header:
* Select Type: |Table - |
* Source Type: | Datasource - | * Linktype | Ds1 - |
Variable Source:
Type: @ Literal () Constant Distinct:
 Source Attributes
C T 1 = T
Select Action with SQL table
% catalogvalidation.rul (% catalogvalidation.rul#Cnt_Select Action with table datasource and sql &2 =0
st
@4 Condition & Actions
I
Then of select using table...
of select with table sgl 1
Else
|g='¢ Actions L8
4 k
= Properties 2 E.; Problemq @] Error Log} ¥ Data Source Explorer} = Console} g | &~ =0
« select with table sql
1 ‘
General Name: select with table sql * Mo value: |Defau|t v|
Advanced
Show On Input: Show Header:
* Select Type: |Table - |
* Source Type: | SQL -] * Linktype | JUNT(varlinkCatalogACCOUNT) ~ |
Variable Source:
Type: @ Literal (7 Constant Distinct:
~ Source Attributes
T 1 = i
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Slice Action

(Short Description to be added).

In this example, a slice action is defined.

Slice Action

ﬁtﬁ *catalogvalidation. rul ﬁtﬁ *atalogvalidation.rul#Cnt_Slice Action &2

@ Condition

L

Slice Action General Properties

Then

143

E':> Actiors

ERf slice test

B Properties 2 Eﬁ_\ Problems | €] Errer Log ¥ Data Source Explorer| B Console =t | ~=a

BER slice test

General Name:

* Source Type:

Data Array Type
Variable And
Attributes:

Order By:
* Where

Where:

Sample - 2

slice test
SQL - * Linl_d:ype ADDRESS(MCL) -
Variable Source:

Literal Attribute

ARR_PROD_KEY_ID MCL/PRODUCTID £

ARR_PROD_ID MCL/PRODUCTIDEXT

Distinct:
[MCL.ADDRESS1 = 'test’ and MCL.PRODUCTIDENXT != 'test’) -

The following is a sample rulebase which has all the commonly used action.

The Rulebase type used in this sample is of type validation.

Rulebase Sample 2

TIBCO® MDM Studio Rulebase Designer User's Guide




144

Repository : CUSTOMER

[ peclare variahles [E] Declare Constraints

=Ny varlinkRelRecordCust ToAdd Bﬁn Cnt_acc_Chk_Prp Actiors
=N varlinkRecord L'@a Cnt_fsg_Clr_Chn Actiors
= varlinkRelCust Toadd L@P Cnt_Sel_sli_Sof Actiors
=y varlinkCatalogCustomer f@a Cht_AssignArray Action

S varDs fr Crit_sSoftlinkaction

B vararray L'@a Cnt_addressConnectacion
“evarl

=y varADDRESSRECORDS

Constraint with Access Check and Inline-Propagate (with Assign) actions
(Short Description to be added).

In this example, a constraint with access, check and inline-propagate (with assign) actions are
described.
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Constraint with Action, Check and Inline propagate action

@ Condition

> < Expression

% *demoallactions. rul % *demoallactions. rul#Cnt_scc_Chk_Prp Actiot& bt
EE

|g='¢ Actiors

Then @ Accesshohon

@ Accesshction

Elsef

2 Checkaction

|g='¢ Actiors

o Propagatesction-Inks

& AssignActia‘@

E Properties &2 E_g Problems} @ Error Log}

l@' Cnt_Acc_Chk_Prp Actions
I

General * Name: | Cnk_acc_Chk_Prp Actions

* Description:

Constraint with Access, Check and Inline-Propagate {with Assign) actions,

Use_ Far [T Select al
wvariables: ]

|

|

Access Properties

ar
jin]
IDEXT
CONTAINS
MAME

|5 Properies £3., €. Problems| @) rrr Log| =R
@ Access Action
I
General MName: |&ccessAction
* Mode: |Hide v|
* Applies to: | Use For Vars - |
Access Action Properties
= Properties &2 & Problems} @Error Log] % ¥ =g
@ AccessAction
7
General Mame: |AccessActmr\ ‘
* Mode: |Hide :“ =]
+ Applies to: |Re\atmnsmp Attributes :“
* Link Relationship |var1 [CustomerToAddress/RESIDENCE] i“

Type Wariable:

145
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Check Action Properties

= propertiss 2 [2 Prablems| €] Error Log

& CheckAction

General —

e
| Checkdction
Advanced

Explanation: Customer 'name’ cannat be blank

Infarmation:

£

Propagate InlineAction Properties

= Properties 52 . [21 Problems | @] Error Log

% Propagate Inline-Type Action Propagate-InlineAction

General Mame: | Propagate-Infineéction

&7
q

0
o

+# Lirk Relationship- |varhnkRe\RecurdCustTuAdd
Record Type

Wariable:

Assign Action Properties

= Properties &2 [L Problems @ Error Log
%@ AssignAction

General

[

Mame:

| AssignAction
Advanced

* Bssign:

ADDRESSL | = Mink, PRODUCTID

>

\

[

54

Constraint with Assign Clear Include and Connect actions
(Short Description to be added).

In this example constraint with assign, clear, include, and connect actions are described.
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Constraint with Assign, Clear, Include and Connect actions

m_«‘a *demoallactions. rul E&_«‘a *demoallactions. rul#Cnt_ssg_Clr_Cnn Actions 23
@ Condition
Uil GroupExpression
If Then
> € Expression 4p > € Expression —
Else
b E':> Actiors
0=0 ConnectAction

Uil GroupExpression

> < Expression

o > < Expression

E Properties &2 [21 Problems QI Error Log

L'aﬁ& Cnt_Asg_Clr_Cnn Actions

General * Name: Cnk_asg_Clr_Cnn Actions
* Description: Constraink with Assign, Clear, Include and Connect actions,
Use Far [T sSelectal | wvar
wvariables:

Constraint with Select
(Short Description

In this example constraint with select, slice and softlink actions are described.

] D

] IDEXT
CONTAINS
HAME

Slice and Softlink actions
to be added).

E':> Actiors

=+ Assignaction

=+ Assignaction

=+ Assignaction

(3 ClearAction

147

TIBCO® MDM Studio Rulebase Designer User's Guide



148

Constraint with Select, Slice and Softlink actions

“-«‘6 *demoallactions. rul “-«‘6 *demoallactions.rul#Cnt_Sel_Sli_Sof Actions &2

@ Condition
LA
»< Expression Then
Else
E':> Actiors

o SelectAction

o SelectAction

ERA Slicesction

o SelectAction

@7 softinkaction

] Properties £3 [2{ Problems _@_I Error Log

Bﬁ& Cnt_Sel_sli_Sof Actions

General

—nt_Sel sl Sof Actions|

* Mame:

* Description: Constraint with Select, Slice and Softlink actions,

Use Far [T sSelectal | wvar
wariables: 7l o
L] IDEXT
L] COMNTAINS
L] HAME

Constraint with Assign action having array assignment

(Short Description to be added).

In this example a constraint with assign action having array assignment is described.
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Constraint with assign action having array assignment

rsfa *demoallactions. rul E&% *demoallactions. rul#Crt_assignérrayiction 23
@4 Candition & actiors
LA
Then = Assignaction
Elsef
E':> Actiors
E Properties &2 |2 Problems 6_| Error Log
#fr Cnt_AssignArrayAction
General * Name: Cnk_AssignirrayAction
* Description: Constraink with Assing action having array assignment,
Use F§|r [T Selectal | var
warlables: D o
3] IDERT
3] CONTAING
3] MAME
Assign Action General Properties
El Properties &2 [21 Problems | €] Error Log
= AssignAction
General Marne: Assignaction I
Advanced
* fssign: warhrray w| o=| A& e, T

Constraint with Softlink action
(Short Description to be added).

In this example constraint with softlink action is described.
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Constraint with Softlink Action
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% *demoallactions, rul (% *demoallactions. rul#Cnt_Softlinkaction &2
@ Condition 2 Actiors
If
Then @2 SoftinkAction
Else
E Actiore
= Properties &2 E; Problems} @ Error Lng}
l@l Cnt_SoftlinkAction
1
General * Marme: | Crk_Softlinkaction
* Description: Constraint with Softlink action,
Llse_ Fglr [T selectal  Var
variables: O] D
i3] IDEXT
Ld] CONTAING
L] MAME
Softlink Action General Properties
*
= Properties &2 E_L F‘roblems\l @ Error Logw
@ softlinkAction
]
General Mame: | Softlinkaction
#* Mode: |Record
where: wvarlinkCatalogCustomer PRODUCTID = "si'
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Constraint with Connect action
(Short Description to be added).

In this example constraint with connect action is described.

Constraint with Connect action

% *demoallactions. rul
11| @A candition [& actiors
Ean
Then o=a CgninectAction
Elsef
|g='¢ Actiors
| E Properties &2 E_( Problems} @ Error Log}
l@l Cnt_AddressConnectAction
I
General * Name: | Cnt_addressConnectaction
* Description: Constraint with Connect action,
Use Fglr [T sSelectall | wvar
warlables: D o
2] IDERT
I 2] CONTAING
2] MAME
Connect action General Properties
= Properties &2 E_(, Problems} @ Errar LDQW
=a ConnectAction
— b
General Mame: | ConnectAction
* Relationship: |Cust0merTOF\ddress
# LnkRecord- | varADDRESSRECORDS
Type Yariable:
Attributes: Attribute Value
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(Short Description to be added).

This appendix lists the context variables.

Context Variables

The followings special variables can be used in a rulebase:

SESSION

WORKITEM

PREVIOUS_VERSION PREVIOUS_CONFIRMED_VERSION
RECORD_ACTION

RECORD_SUB_ACTION

RECORD_IS_TOPMOST

RECORD_IS_BOTTOMMOST

PARENT

CHILD

WORKFLOW

SESSION

The following table lists session variables that can be used without explicit declaration.

Variable Type Value
SESSION/DATE date Current date.
SESSION/USER_ID string User ID of current user.
SESSION/USER_ROLES array Roles this user belongs to.
SESSION/ORGANIZATION_NAME string Organization Name.
SESSION/ORGANIZATION_TYPE string Organization type.
SESSION/ORGANIZATIONID number Organization identification
number
SESSION/TIMESTAMP timestamp Date and Time
SESSION/ENTERPRISE_NAME string Enterprise Name.
SESSION/ENTERPRISE_INTERNAL_NAME string Enterprise Internal Name.
SESSION/LANGUAGE string User profile's language locale
value.
SESSION/COUNTRY string User profile's country locale

value.
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Variable

SESSION/LANGSEL string Language locale selected from
Login page.

The following example shows an access rule which restricts access to the attribute
“SENSITIVE_ATTRIBUTE” only to Admin users. Notice that “in” has to be used, because a user can
belong to more than 1 role, and USER_ROLES therefore returns an array of values.

<constraint>
<name>HideSensitiveAttribute</name>
<description>Only Admin Role can see Sensitive Attribute</description>
<condition>
<in>
<const type="string">Admin</const>
<var>SESSION/USER_ROLES</var>
</in>
</condition>
<action>
<access mode="modify">SENSITIVE_ATTRIBUTE</access>
</action>
<action>
<access mode="hide">SENSITIVE_ATTRIBUTE</access>
</action>
</constraint>

The following example shows usage of SESSION/LANGUAGE, SESSION/COUNTRY and SESSION/
LANGSEL.

<constraint>

<name>Set Language</name>

<description>Get Lanaguage from SESSION.</description>
<action>

<assign>

<var>language</var>

<var>SESSION/LANGUAGE</var>

</assign>

</action>

</constraint>

<constraint>

<name>Set Country</name>

<description>Get Country from SESSION.</description>
<action>

<assign>

<var>country</var>

<var>SESSION/COUNTRY</var>

</assign>

</action>

</constraint>

<constraint>

<name>Set Language Sel</name>

<description>Get ui language selected SESSION.</description>
<action>

<assign>

<var>uilang</var>

<var>SESSION/LANGSEL</var>

</assign>

</action>

</constraint>

After selecting language and country in User Accounts screen, the MDM administrator has to logout
& and login as the user for whom the language and country selection is done. Otherwise these settings are
persisted through the current session.

WORKITEM

Each step in the workflow has dependent criteria, and requires specific variables to be defined.

The following table lists variables, their types, and values.
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Variable Type Value

WORKITEM/ACTIVITY_NAME string Name of current activity.

WORKITEM/SEVERITY number Workitem Severity.

WORKITEM/STEP_SEVERITY number Workitem Step Severity.

WORKITEM/DOCTYPE string Document Type that created
workitem.

WORKITEM/DOCSUBTYPE string Document Sub-Type that created
workitem.

WORKITEM/ERRORS number Number of errors in the record
bundle.

WORKITEM/WARNINGS number Number of warnings in the

record bundle.

WORKITEM/REJECTIONS number Number of rejections in the
record bundle.

WORKITEM/TRADING_PARTNER string Trading Partner Name.
WORKITEM/TRADING_PARTNER_TYPE string Trading Partner Organization
Type.
WORKITEM/MARKETPLACE_NAME string Marketplace name.
WORKITEM/MASTER_CATALOG_NAME string Name of the repository of the

record being processed.

WORKITEM/MASTER_CATALOG_VERSION Number Repository Version.

WORKITEM/INTENT String Intent passed in to WorkItem
activity.

WORKITEM/RECORD_COUNT Number Total number of records in the
bundle.

WORKITEM/SUCCESS_COUNT Number Number of records with no
erTors.

Custom* String Any Parameter starting with
“Custom” that is passed to
Workitem Activity.

PREVIOUS_VERSION PREVIOUS_CONFIRMED_VERSION

You can access previous unconfirmed and confirmed versions of the records with two explicitly
defined contexts.

The following table lists these contexts.
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Context Description

PREVIOUS_VERSION Latest confirmed or unconfirmed version.

PREVIOUS_CONFIRMED_VERSION Last confirmed version.

The following example shows how to access the weight attribute value of the last confirmed version:
<var>PREVIOUS_CONFIRMED_VERSION/WEIGHT</var>

In MDM 8.2, you can also use this context variable to check record modification status.

<constraint>
<name>TestChanged</name>
<description>test changed</description>
<condition>
<changed>
<const type="string">PREVIOUS_CONFIRMED_VERSION</const>
</changed>
</condition>
<action>
<assign>
<var>notes</var>
<const type="number">Record has changed</const>
</assign>
</action>
</constraint>

CONTEXT_RELATIONSHIP NAME

While adding a new record and executing the “newrecord” rulebase, the CONTEXT_RELATIONSHIP
variable contains the name of a relationship if the record is added by selecting the “add” action and
then the relationship name on an existing record.

For example, if you are keeping a Vendor repository which has a relationship for multiple addresses,
then you can automatically set the “RECORD_TYPE” to address if the user is adding a new address
relationship.

<constraint>
<name>Vendor_Record_Type</name>
<condition>
<undefined>
<var>CONTEXT_RELATIONSHIP/NAME</var>
</undefined>
</condition>
<action>
<assign>
<var>RECORD_TYPE</var>
<const type="string">VENDOR</const>
</assign>
</action>
</constraint>
<constraint>
<name>Address_Record_Type</name>
<condition>
<eq>
<var>CONTEXT_RELATIONSHIP/NAME</var>
<const type="string">ADDRESS_REL</const>
</eq>
</condition>
<action>
<assign>
<var>RECORD_TYPE</var>
<const type="string">ADDRESS</const>
</assign>
</action>
</constraint>
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The following is another example of assigning the RECORD_TYPE based on the Context Relationship.

<constraint>
<name>PRODUCT</name>
<condition>
<undefined>
<var>CONTEXT_RELATIONSHIP/NAME</var>
</undefined>
</condition>
<action>
<assign>
<var>RECORD_TYPE</var>
<const type="string">PRODUCT</const>
</assign>
</action>
</constraint>
<constraint>
<name>SKU</name>
<condition>
<eqg>
<var>CONTEXT_RELATIONSHIP/NAME</var>
<const type="string">PRODUCT_TO_SKU_REL</const>
</eq>
</condition>
<action>
<assign>
<var>RECORD_TYPE</var>
<const type="string">SKU</const>
</assign>
</action>
</constraint>

RECORD_ACTION

Possible values:

RECORD_ACTION Escaped Version

ADD New record is being added.

EDIT Existing record is being edited.

COPY New Record is being copied from another record.

VIEW Record is being viewed.

MASS_UPDATE Executes a constraint only when the mass update is in process, that is,

the same validation file can be used for record edit and mass update.

Refer tomass_update.

RECORD_SEARCH The record search is being executed. If a constraint is defined with this
action, the same catalog validation file can be used for record search
screen if the property com.tibco.cim.recordsearch.rulesfile is
configured with catalog validation file name.

The following example restricts view access to the BASE_UNIT, ITEM_BRAND_NAME, and
BRAND_OWNER_ID attributes, if the record is being viewed or edited:

<constraint>
<name>ViewOnlyGeneralAttributesForViewAndChange</name>
<description>View only attributes for View and Change</description>
<condition>
<or>
<eg>
<var>RECORD_ACTION</var>
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<const type="string">EDIT</const>
</eq>
<eg>
<var>RECORD_ACTION</var>
<const type="string">VIEW</const>
</eq>
</or>
</condition>
<action>
<access mode="view">BASE_UNIT</access>
<access mode="view">ITEM BRAND_NAME</access>
<access mode="view">BRAND_OWNER_ID</access>
</action>
</constraint>

mass_update

This value allows you to execute a constraint only when the mass update is in process, that is, the same
validation file can be used for record edit and mass update.

The RecordAction filter can be used for mass update as shown in the following example:

<constraint>
<name>Check-int</name>
<description>Check-int</description>
<usefor>
<var>TEST_INT</var>
</usefor>
<condition>
<eqg>
<var>RECORD_ACTION</var>
<const type="string">MASS_ UPDATE</const>
</eq>
</condition>
<action>
<check>
<explanation>TEST INT should only be 1l</explanation>
<and>
<defined>
<var>TEST_INT</var>
</defined>
<eqg>
<var/>
<const type="number">1</const>
</eqg>
</and>
</check>
</action>
</constraint>

record_search

The following is an example of a constraint to be used when RECORD_ACTION=RECORD_SEARCH is
used:

<constraint>
<name>TestSQLIN</name>
<description>Test Get with SQL query using IN</description>
<usefor>
<var>Installments</var>
</usefor>
<condition>
<eq>
<var>RECORD_ACTION</var>
<const type="string">RECORD_SEARCH</const>
</eq>
</condition>
<action>
<select>
<table source="datasource">
<literal>CUSTDS1</1literal>
<literal>INSTALLMENT</literal>
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<where>
<sqgl>
<in>
<literal>INSTALLMENT</literal>
<const type="number">34000</const>
<const type="number">23000</const>
</in>
</sql>
</where>
</table>
</select>
</action>
</constraint>

RECORD_SUB_ACTION
Currently, the only possible value that can be assigned to this variable is RESTORE.

When a record is restored, for all Ul based rulebase validations for restored record,
RECORD_SUB_ACTION is set to RESTORE.

RECORD_SUB_ACTION is bound to RESTORE only for UI based validations and not during workflow
& y 5
processing.

RECORD_IS_TOPMOST

This variable allows you to check whether the record is the topmost in the hierarchy.

Example

<constraint>

<name>Test for parent</name>
<description>To Check if this is the parent</description>
<usefor>

<var>SHORTDESC</var>

</usefor>

<condition>

<and>

<eq>

<var>RECORD_TYPE</var>

<const type="string">CUST</const>
</eq>
<var>RECORD_IS_TOPMOST</var>
</and>

</condition>

<action>

<assign>

<var>SHORTDESC</var>

<const type="string">Parent Record</const>
</assign>

</action>

</constraint>

RECORD_IS_BOTTOMMOST

This variable allows to check whether the record is bottommost in the hierarchy.

Example

<constraint>

<name>Test for child/leaf node</name>
<description>To Check if this is the leaf node in a hierarchy of records</
description>

<usefor>

<var>SHORTDESC</var>

</usefor>

<condition>

<and>

<eqg>

<var>RECORD_TYPE</var>
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<const type="string">CUST</const>
</eq>
<var>RECORD_IS_BOTTOMMOST</var>
</and>

</condition>

<action>

<assign>

<var>SHORTDESC</var>

<const type="string">Child Record</const>
</assign>

</action>

</constraint>

PARENT

&

CHILD

This variable allows to access attribute values of a parent record during relationship catalog rulebase
execution.

This context variable is only available in relationship catalog rulebase execution. The parent/child
record is always determined in context of forward relationship.

Example

<constraint>
<name>checkForAssetType</name>
<description>To Check if asset type is defined</description>
<usefor>
<var>ASSET_TYPE</var>
</usefor>
<condition>
<defined>
<var>PARENT/HAS_ASSETS</var>
</defined>
</condition>
<action>
<check>
<explanation>Asset type should be defined.</explanation>
<defined>
<var>ASSET_TYPE</var>
</defined>
</check>
</action>
</constraint>

This variable allows to access attribute values of child record during relationship catalog rulebase
execution.

This context variable is only available in relationship catalog rulebase execution. The parent/child
record is always determined in context of forward relationship.

Example

<constraint>
<name>checkForRegion</name>
<description>To Check if region is defined</description>
<usefor>
<var>REGION</var>
</usefor>
<condition>
<defined>
<var>CHILD/ZIPCODE</var>
</defined>
</condition>
<action>
<check>
<explanation>REGION type should be defined.</explanation>
<defined>
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<var>REGION</var>
</defined>
</check>
</action>
</constraint>

WORKFLOW

The following table lists session variables that can be used to access values of workflow.

Variable

ACTIVITY_NAME String Activity Name.

TIBCO® MDM Studio Rulebase Designer User's Guide



161

Tips and Tricks

Tips

(Short Description to be added).

This appendix lists some tips and tricks that you may find useful while working with the Rulebase
Designer.

(Short Description to be added).

While refreshing Rulebase Data View, make sure that the respective rulebase diagram is open and
set as the active diagram.

Tooltips on the Rulebase Data view contain some examples for rulebase functions. You can select an
example and drag and drop it directly to the Expression Editor.

While defining an expression in the condition compartment, make sure that the expression flow of
connecting operators (“and”,”or”) is from left to right. The operators are provided with an arrow
head on the right side.

To arrange constraints and actions, select the constraint or action and drop it to the appropriate
location in the respective container. To rearrange, select Main Canvas and press Ctrl + SHIFT +F.

To resize a container, press Auto Size on the toolbar.

Cut/Copy/Paste is allowed in variables, constraints and actions. Press Ctrl+C for copying and Ctrl+V
for pasting.

Save a diagram immediately after modification.

When you modify an expression, always click Save in the Expression Editor followed by a diagram
Save immediately.

For Undo in the Expression Editor, press Ctrl + z.
For Redo in the Expression Editor, Ctrl +y.
In the Expression Editor, press Ctrl + Space to invoke the “Content Assist”.

When there is a problem in an expression, you can refer to the actual problem by navigating
through the Problems View.

In the variable reference section, click on a variable to find its usage. A reference list is displayed.
Double clicking on a reference in this list, navigates to the action in which this variable is used.
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(Short Description to be added).

This appendix lists the classification functions.

getClassificationScheme

Description

Retrieves the
Classification
Scheme with the
name
"classificationSche
meName" in
repository
"repositoryName"

Parameters Returns

repositoryName: Specify  the object of type

the repository name. classification
scheme.

classificationSchemeNa

me: Specify the

classifcation scheme

name.

Example

<op
func="getClassificationS
cheme"> <const
type="string">mycatalogNar
const> (any expression
that evaluates to
string)

<const
type="string">myschemeNamg
const> (any expression
that evaluates to
string)

</op>

(Short Description to be added).

IsRecordCategorizedUnderScheme

Description

Checks whether
present record is
classified or
categorized under
the mentioned
classification
scheme

Parameters Returns

classificationScheme: true or false.
Specify the classifcation
scheme object.

Example

<op
func="isRecordCategorize
dUnderScheme">
<var>LINK_CSCHEME</var>
or any expression that
evaluates to
classification scheme
</op>

(Short Description to be added).
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Description

Parameters

Returns
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Example

Retrieves the
classification code
object using
provided parent
code object and the
code string

parentCode: parent
classification code object
(link type

classificationcode).

Child classificationCode:

Child classification code
string.

classification
code object

<op
func="getClassificationC
odeByCode">

<var>LINK_ CCODE</var> or
any expression that
evaluates to
classification code
<const
type="string">code</

const> <!-- the code to
retrieve --> </op>
(Short Description to be added).
getClassificationCodeByName
Description Parameters Returns Example
Retrieves the parentCode: parent classification <op

classification code
object using
provided parent
code object and the
code NAME string

classification code object

(link type
classificationcode).

Child

classificationCodeName:

Child classification code
NAME string.

code object

func="getClassificationC
odeByName ">

<var>LINK CCODE</var> or
any expression that
evaluates to
classification code
<const
type="string">codename</
const> <!-- the code
NAME to retrieve -->
</op>

(Short Description to be added).
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getClassificationCodeForCodesInPath

Description Parameters Returns Example
Constructs a classificationScheme: the  classification <op
classification code  classification scheme code object func="getClassificationC
object from given (link type classification). odeForCodesInPath">

ath of codes in
p treepathOfCodes: the full <var>LINK_CSCHEME</var>
the scheme

treepath of codes from or any expression that

root code. evaluates to
classification scheme

mentioned

<const
type="string">rootcode/
firstLevel/secondLevel/
mycode</const> </op>

(Short Description to be added).

getClassificationCodeForCodeNamesinPath

Description Parameters Returns Example
Constructs a classificationScheme: the  classification <op
classification code  classification scheme code object func="getClassificationC
ObjeCt fOI‘ glven (11nk t’ype Classification). odeForCodeNamesInPath">
ath of code
Eames o the treepathOfCodeNames: <var>LINK_CSCHEME</var>
scheme the full treepath of code or any expression that
. names from root code . evaluates to
mentioned.

classification scheme
<const
type="string">rootcode/
firstLevelCodeName/
secondLevelCodeName/
mycodeName</const> </op>

(Short Description to be added).
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Description

Parameters Returns
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Example

Checks whether
current record is
categorized under
the mentioned
code path.

classificationScheme: the  true or false
classification scheme link

object

treepathOfCodes:the full
treepath of codes from
root code

<op
func="isRecordCategorize
dUnderCodesPath">

<var>classificationSchemes
var>

<const
type="string">rootcode/
firstLevel/secondLevel/
mycode</const>

</op>

(Short Description to be added).

iIsRecordCategorizedUnderCodeNamesPath

Description

Checks whether
current record is
categorized under
the mentioned
code name path.

Parameters Returns

classificationScheme: the  true or false
classification scheme link
object

treepathOfCodeNames:t
he full treepath of code
names from root code.

Example

<op
func="isRecordCategorize
dUnderCodeNamesPath">

<var>classificationScheme{

var>

<const
type="string">rootcode/
firstLevelCodeName/
secondLevelCodeName/
mycodeCodeName</const>

</op>

(Short Description to be added).

TIBCO® MDM Studio Rulebase Designer User's Guide

/

/



166

iIsRecordCategorizedUnderMultipleCodePaths

Description

Checks whether
current record is
categorized under
all provided array
of code paths

Parameters

classificationScheme: the
classification scheme link
object

arrayOfTreepathOfCode
s:an array of full treepath
of codes from the root
code

Returns Example

true or false <op
func="isRecordCategorize
dUnderMultipleCodePaths"
>

<var>classificationSchemes
var>

<const
type="string">rootcode/
firstLevel/secondLevel/
mycodeONE</const>

<const
type="string">rootcode/
firstlLevel/secondLevel/
mycodeTWO</const>

<const
type="string">rootcode/
firstLevel/secondLevel/
mycode_N</const>

</op>

(Short Description to be added).
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iIsRecordCategorizedUnderMultipleCodeNamePaths

Description Parameters Returns Example

Checks whether classificationScheme: the  true or false <op

current record is classification scheme link func="isRecordCategorize

categorized under  object dUnderMultipleCodeNamesP

all provided arra "

P Y arrayOfTreepathOfCode aths">

of code names N

paﬂn& ames <var>classificationSchemes
var>
<const

type="string">rootcode/
firstLevel/secondLevel/
mycodeNameONE</const>

<const
type="string">rootcode/
firstlLevel/secondLevel/
mycodeNameTWO</const>

<const
type="string">rootcode/
firstLevel/secondLevel/
mycodeName_N</const>

</op>
(Short Description to be added).
getClassificationCodePathsForRecord
Description Parameters Returns Example
Returns the array =~ None array of all the <op
of all code paths treepaths of func="getClassificationC
under which codes. odePathsForRecord">
current record is " </op>
classified/ [ rootsode/catl/../
categoriezed codel”,
& ’ "rootcode/cat2/../
code2",
"rootcode/cat3/../
code3"]

(Short Description to be added).
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getClassificationCodeNamePathsForRecord

Description Parameters
Returns the array None

of all code NAME

paths under which

current record is

classified/

categoriezed.

Returns Example

array of all the <op

treepaths of code  func="getClassificationC
names odeNamePathsForRecord">

["rootcode/catl/../ </°P>
codeNAME1",
"rootcode/cat2/../
codeNAME?2",
"rootcode/cat3/../
codeNAME3"]

(Short Description to be added).

getClassificationCodesForRecord

Parameters

Description

Returns the array None
of all classification

code strings under

which current

record is classified/
categorized.

Returns Example
array of code <op
strings. func="getClassificationC

" won " odesForRecord"> </op>
["codel", "code2

7 4
"code3", ...]

(Short Description to be added).

getClassificationCodeNamesForRecord

Parameters

Description

Returns the array None
of all classification

code NAME

strings under

which current

record is classified/
categorized.

Returns Example
array of code <op
names func="getClassificationC

["codeNAMEl" odeNamesForRecord">
"codeNAME2", </op>

"codeNAME3", ...

]

(Short Description to be added).
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getClassificationCodelLevel

Description Parameters Returns Example

Retrieves the level  classificationCode:classif  level for this code  <op

for provided ication code object eg. 1,23 etc func="getClassificationC
classification code odeLevel">
object. <var>LINK_C_CODE</var>

or any expression that
evaluates to
classification code
</op>

(Short Description to be added).

IsSubCategoryOfCode
Description Parameters Returns Example
Checks whether classificationScheme: true or false <op
provided classification scheme func="1isSubCategory0fCod
classification code  object e"> <var>LINK CSCHEME</

is sub-category of
mentioned parent
code in the given

classification childCode: child code
scheme. string

parentCode: parent code var> or any expression
string that evaluates to
classification scheme
<const
type="string">parentCode<
const> <const
type="string">childCode</

const> </op>

(Short Description to be added).

iIsSubCategoryOfCodeName

Description Parameters Returns Example
Checks whether classificationScheme:clas  true or false <op
provided sification scheme object func="1isSubCategory0fCod
classification code "
parentCodeName: eName™>

name is sub-
category of
mentioned parent  childCodeName: child

<var>LINK_CSCHEME</var>
or any expression that

parent code name string

evaluates to

code name in the code name string e

. e . classification scheme
given classification <const
scheme.

type="string">parentCodeNgme</
const> <const
type="string">childCodeNanfe</
const> </op>
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stringTreepathOfCodeToClassificationCode

Description

Parameters

Returns

170

Example

Constructs
classification code
objects for the each
treepath provided
in the array of
code paths.

repositoryName: name
of the repository

classificationSchemeNa
me: name of the
classification scheme

arrayOfTreepathOfCode
s:an array of full treepath
of codes from the root
code

array of
classification
code objects for
provided
treepaths

<op
func="stringTreepathOfCo
deToClassificationCode">

<const

type="string">repositoryName</

const> <const
type="string">schemeName<
const> <const
type="string">rootcode/
catl/..../codel</const>
<const
type="string">rootcode/
cat2/..../code2</const>
<const
type="string">rootcode/
cat3/..../code3</const>
</op>

(Short Description to be added).

stringTreepathOfCodeNamesToClassificationCode

Description

Parameters

Returns

Example

Constructs
classification code
objects for the each
treepath provided
in the array of
code name paths
in parameter

repositoryName: name
of the repository

classificationSchemeNa
me: name of the
classification scheme

arrayOfTreepathOfCode
Names: an array of full
treepath of code names
from the root code.

array of
classification
code objects for
provided
treepaths

<op
func="stringTreepathOfCo
deNamesToClassificationC
ode"> <const
type="string">repositoryNa3
const> <const
type="string">schemeName<
const> <const
type="string">rootcode/
catl/..../codeNamel</
const> <const
type="string">rootcode/
cat2/..../codeName2</
const> <const
type="string">rootcode/
cat3/..../codeName3</
const> </op>

ime </

(Short Description to be added).
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Description

Parameters

Returns

171

Example

Checks whether
current record is
categorized under
provided code
under mentioned
scheme.

ClassificationSchemeNa

me: name of the

classification scheme

ClassificationCode:

Classification code link

object

true or false

<op
func="isRecordCategorize
d"> <var>LINK_ C_SCHEME</
var> <var>LINK C_CODE</
var> </op>

(Short Description to be added).

IsSRecordCategorizedUnderAll

Description

Parameters

Returns

Example

Checks whether
current record is
categorized under
all the code
provided in list
under mentioned
scheme.

ClassificationSchemeNa

me: name of the

classification scheme

list of classifiication code
link objects: An output of

other classification
custom function.

flag: true or false

true or false

If the flag is set
true, then this
method returns
true ONLY IF the
record is
categorized
under ALL codes
in the given list.

If the flag is set
false, then this
method returns
false ONLY IF the
record is NOT
categorized
under ANY codes
in the given list of
codes.

<op
func="isRecordCategorize
dUnderAll">
<var>LINK_C_SCHEME</var>
<op
func="stringTreepathOfCo
deNamesToClassificationC
ode"> <const
type="string">repositoryNa3
const> <const
type="string">schemeName<
const> <const
type="string">rootcode/
catl/..../codeNamel</
const> <const
type="string">rootcode/
cat2/..../codeName2</
const> <const
type="string">rootcode/
cat3/..../codeName3</
const> </op> <const
type="boolean">true</
const> </op>

ime </

(Short Description to be added).
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